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Preface

This document describes how to install and use the Event Replicator Target Adapter Administration
to configure your Event Replicator Target Adapter installation.

‘J Notes:

1. The Event Replicator Target Adapter must be stopped and restarted every time an Event
Replicator Target Adapter definition is saved or deleted using the Administration tool. For this
reason, we recommend that you shut down the Event Replicator Target Adapter prior to making
changes to the definitions and restart the Event Replicator Target Adapter when all definition
changes are complete. For information about stopping and starting the Event Replicator Target
Adapter, read Shutting Down the Event Replicator Target Adapter and Starting the Event Replicator
Target Adapter, in the Event Replicator Target Adapter User Guide.

2. The Event Replicator Target Adapter Administration Tool and the Data Mapping Tool are not
supported in AIX, HP-UX, Solaris or zLinux environments because the Eclipse RCP port is not
available in those environments. You will need to have a Windows or Linux installation of the
Administration Tool and Mapping Tool to use them. The Administration Tool can remotely
manage Event Replicator Target Adapter installations on those platforms where the Eclipse
RCP is not supported.

This document covers the following topics:

Event Replicator Target Adapter Provides an overview of Event Replicator Target Adapter
Administration Overview Administration.
Release Notes Describes the updates to Event Replicator Target Adapter

Administration since the last release.

Installing Event Replicator Target Adapter|Describes the prerequisites, system requirements, and steps
Administration to install and uninstall Event Replicator Target Adapter
Administration.

About the Event Replicator Target Adapter|Describes the Administration tool interface as well as how to
Administration Tool start and stop it.

Activating Your Event Replicator Target  |Describes the activation of your Event Replicator Target
Adapter or Adabas Analytics Collector MF|Adapter Administration license.
License

Maintaining the Event Replicator Target |Describes the Event Replicator Target Adapter engine

Adapter Engine Configuration configuration parameters and how to maintain them.
Maintaining the Event Replicator Target |Describes the Event Replicator Target Adapter persistent store
Adapter Persistent Store (WebDAV) (WebDAV) configuration parameters and how to maintain
Configuration them.
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Configuring Target Definitions for Event
Replicator Target Adapter

Describes how to configure the Event Replicator Target
Adapter target definitions for your target RDBMS databases
and web services.

Configuring Target Definitions for Adabas
Analytics Collector MF

Describes how to configure the target definitions for Adabas
Analytics Collector MF.

Specifying Target Database Processing
Option Definitions

Describes how to specify options for Event Replicator Target
Adapter processing with target RDBMS databases.

Specifying Filter Definitions

Describes how Event Replicator Target Adapter filter
processing works and how to maintain filter definitions for
filter processing.

Configuring Source Definitions for Event
Replicator Target Adapter

Describes how to configure the Event Replicator Target
Adapter source definitions for the webMethods EntireX or
WebSphere MQ messaging systems you are using.

Configuring Source Definitions for Adabas
Analytics Collector MF

Describes how to configure the source definitions for Adabas
Analytics Collector MF.

Verifying Your Source Definition
Connections

Explains how to verify the webMethods EntireX or WebSphere
MQ source definition connections you have configured.

Reviewing and Dynamically Altering
Definitions

Describes how you can use the Administration tool to review
and dynamically alter the configuration, source, target, filter,
and target database processing definitions you have specified.

Reviewing Log Files

Describes how to review Event Replicator Target Adapter log
files from the Administration tool.

Reviewing Event Replicator Target Adapter
Statistics

Describes how to review Event Replicator Target Adapter
processing statistics from the Administration tool.
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About this Documentation

Document Conventions
Convention Description
Bold Identifies elements on a screen.

Monospace font

Identifies service names and locations in the format folder.subfolder.service,
APIs, Java classes, methods, properties.

Italic

Identifies:

Variables for which you must supply values specific to your own situation or
environment.

New terms the first time they occur in the text.

References to other documentation sources.

Monospace font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

Indicates a set of choices from which you must choose one. Type only the information
inside the curly braces. Do not type the { } symbols.

Separates two mutually exclusive choices in a syntax line. Type one of these choices.
Do not type the | symbol.

Indicates one or more options. Type only the information inside the square brackets.
Do not type the [ ] symbols.

Indicates that you can type multiple options of the same type. Type only the
information. Do not type the ellipsis (...).

Online Information and Support

Product Documentation

You can find the product documentation on our documentation website at https://documenta-
tion.softwareag.com.

Product Training

You can find helpful product training material on our Learning Portal at https://learn.software-

ag.com.

Tech Community

You can collaborate with Software GmbH experts on our Tech Community website at https://tech-
community.softwareag.com. From here you can, for example:
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About this Documentation

Browse through our vast knowledge base.

Ask questions and find answers in our discussion forums.

Get the latest Software GmbH news and announcements.

® Explore our communities.

® Go to our public GitHub and Docker repositories at https://github.com/softwareag and ht-
tps://hub.docker.com/publishers/softwareag and discover additional Software GmbH resources.

Product Support

Support for Software GmbH products is provided to licensed customers via our Empower Portal
at https://empower.softwareag.com. Many services on this portal require that you have an account.
If you do not yet have one, you can request it at https://empower.softwareag.com/register. Once
you have an account, you can, for example:

® Download products, updates and fixes.

® Search the Knowledge Center for technical information and tips.

" Subscribe to early warnings and critical alerts.

Open and update support incidents.

Add product feature requests.

Data Protection

Software AG products provide functionality with respect to processing of personal data according
to the EU General Data Protection Regulation (GDPR). Where applicable, appropriate steps are
documented in the respective administration documentation.

Event Replicator Target Adapter Administration 3
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2 Event Replicator Target Adapter Administration Overview

Use the Event Replicator Target Adapter Administration tool to configure your Event Replicator
Target Adapter or Adabas Analytics Collector MF installations. This can be multiple installations
for different versions and/or different machines.

For each target adapter configured for administration, you can use it to:

Set up Event Replicator Target Adapter processing preferences. These preferences identify,
among other things, the location of the context.xml file used to store the Event Replicator Target
Adapter definitions, the locations of the Event Replicator Target Adapter startup and shutdown
commands, and the location of the Event Replicator Target Adapter log files.

@ Caution: We do not recommend that you alter Event Replicator Target Adapter definitions

in the context.xml file using a text editor or any editor other than the Event Replicator
Target Adapter Administration tool. If you do, errors may result.

Configure the target definitions for your installation. Target definitions define the RDBMS data
base or other types of targets to which the Event Replicator Target Adapter should direct the
replicated data. For more information, read Configuring Target Definitions for Event Replicator
Target Adapter, elsewhere in this guide.

Set up any target processing option definitions needed for Event Replicator Target Adapter
processing. Target database processing option definitions specify options regarding how the
Event Replicator Target Adapter processes the data submitted to the target. For more information,
read Specifying Target Database Processing Options, elsewhere in this guide

Configure the source definitions for your installation. Source definitions define the messaging
system to be used (webMethods EntireX or WebSphere MQ) and associated target definition to
which the Event Replicator Target Adapter should direct the replicated data acquired from the
source definition. For more information, read Configuring Source Definitions for Event Replic-
ator Target Adapter, elsewhere in this guide.

Configure any filter definitions for Event Replicator Target Adapter processing. For more in-
formation, read Specifying Filter Definitions, elsewhere in this guide
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For each Adabas Analytics Collector MF configured for administration, you can use it to:

Set up Adabas Analytics Collector MF processing preferences. These preferences identify, among
other things, the location of the EAPConfig.xml file used to store the Adabas Analytics Collector
MF definitions.

@ Caution: We do not recommend that you alter Adabas Analytics Collector MF definitions

in the EAPConfig.xml file using a text editor or any editor other than the Event Replicator
Target Adapter Administration tool. If you do, errors may result.

Configure the target definitions for your installation. Target definitions define the Elasticsearch
targets to which the Adabas Analytics Collector MF should direct the data. For more information,
read Configuring Target Definitions for Adabas Analytics Collector MF, elsewhere in this guide.

Configure the source definitions for your installation. Source definitions define the messaging
system to be used (webMethods EntireX or WebSphere MQ) or the Event Replicator Target
Adapter JMX bean and associated target definition to which the Adabas Analytics Collector MF
should direct the data acquired from the source definition. For more information, read Config-
uring Source Definitions for Adabas Analytics Collector MF, elsewhere in this guide.

Event Replicator Target Adapter Administration
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Release Notes

This chapter provides release notes for the current version of Event Replicator Target Adapter
Administration. It is organized as follows:

Enhancements

This version of Event Replicator Target Adapter Administration supports administration of Event
Replicator Target Adapter Version 3.9, as well as earlier versions of that product. A single running
instance of Event Replicator Target Adapter Administration has the ability to manage multiple
versions and instances, both local and remote, in a single administration console. The product also
can be used to configure Adabas Analytics Collector MF Version 3.9 and below.

Fixes to Event Replicator Target Adapter Administration are delivered using the Software AG
Update Manager. For more details, see the section Installing Event Replicator Target Adapter
Administration in this documentation.

End of Maintenance

For information on how long a product is supported by Software AG, access Software AG's Em-
power web site at hittps://empower.softwareag.com.

Log into Empower. Once you have logged in, you can expand Products in the left menu of the
web page and select Product Version Availability to access the Product Version Availability ap-
plication. This application allows you to review support information for specific products and
releases.

Documentation and Other Online Information

The following online resources are available for you to obtain up-to-date information about your
Software AG products:

= Software AG Documentation Website
= Software AG TECHcommunity

12 Event Replicator Target Adapter Administration
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Release Notes

= Software AG Empower Product Support Website
Software AG Documentation Website

You can find documentation for all Software AG products on the Software AG Documentation
website at hittps://documentation.softwareag.com. This site requires Empower credentials. If you
do not have an Empower user ID and password yet, you will find instructions for registering on
this site (free for customers with maintenance contracts) or you can also use the TECHcommunity
website to access the latest documentation.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG TECHcommunity
website at http://techcommunity.softwareag.com. You can:

" Access product documentation, if you have TECHcommunity credentials. If you do not, you
will need to register and specify "Documentation” as an area of interest. If you already have
TECHcommunity credentials, you can adjust your areas of interest on the TECHcommunity
website by editing your TECHcommunity profile. To access documentation in the TECHcom-
munity once you are logged in, select Documentation from the Communities menu.

= Access articles, demos, and tutorials.

® Use the online discussion forums, moderated by Software AG professionals, to ask questions,
discuss best practices, and learn how other customers are using Software AG technology.

® Link to external websites that discuss open standards and web technology.
Software AG Empower Product Support Website

You can find product information on the Software AG Empower Product Support website at /1#-
tps://lempower.softwareag.com. This site requires Empower credentials. If you do not have an
Empower user ID and password yet, you will find instructions for registering on this site (free for
customers with maintenance contracts).

To submit feature/enhancement requests, get information about product availability, and download
products and certified samples, select Products & Documentation from the menu once you are
logged in.

To get information about fixes and to read early warnings, technical papers, and knowledge base
articles, select Knowledge Center from the menu once you are logged in.
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Installing Event Replicator Target Adapter Administration

This chapter describes the installation and uninstallation of Event Replicator Target Adapter Ad-
ministration. It covers the following topics:

Installation Overview

This product is installed using the Software AG Installer, which you can download from the
Software AG Empower website at https://empower.softwareag.com/.

The Software AG Installer offers typical development installations of Software AG products. When
you select a typical development installation, the installer automatically groups and selects the
Software AG products and components that make up that installation.

The Event Replicator Target Adapter Administration is part of the Event Replicator Target
Adapter product suite. It is installed separately from Event Replicator Target Adapter Data
Mapping Tool and the Event Replicator Target Adapter.

The Event Replicator Target Adapter Data Mapping Tool is part of the Event Replicator Target
Adapter product suite. It is installed separately from Event Replicator Target Adapter Admin-
istration and the Event Replicator Target Adapter.

The Event Replicator Target Adapter installation is part of the Event Replicator Target Adapter
product suite. It is installed separately from the Event Replicator Target Adapter Administration
and the Event Replicator Target Adapter Data Mapping Tool. Included in the installation of the
Event Replicator Target Adapter is the installation of an internal component called the Software
AG ERTA Administration Service. This service enables running the Event Replicator Target
Adapter as a system service and also allows communication with a remote administration console
(for example on platforms, such as HP and zLinux, where the Event Replicator Target Adapter
Administration tool cannot be installed)

The Infrastructure entry in the Software AG Installer includes the installation of Java. Java
should be installed so it can be accessed by all products in the Event Replicator Target Adapter
product suite and by the Software AG Installer.

You cannot ungroup installations that have been paired or grouped. However, you can select
multiple installation configurations for installation at the same time. To configure your installation

of

these products and create effective production environments, work with your system adminis-

trators and Software AG Global Consulting Services.

18
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Installing Event Replicator Target Adapter Administration

System Requirements

This section describes the system requirements of Event Replicator Target Adapter Administration.

= Supported Operating System Platforms
= Supported Hardware

= Supported Browsers

= Supplied Third-Party Software

= Space Requirements

= Memory Requirements

= Windows Requirements

= Firewall Requirements

| Note: We recommend that you read the install.txt file in the CD root directory for last-minute

information regarding the installation of the Event Replicator Target Adapter. We also re-
commend that you read the Event Replicator Target Adapter ReadMe.txt files for last-minute
information regarding its operation. The Event Replicator Target Adapter readme.txt file
can be found in the CD root directory.

Supported Operating System Platforms

Software AG generally provides support for the operating system platform versions supported
by their respective manufacturers; when an operating system platform provider stops supporting
a version of an operating system, Software AG will stop supporting that version.

For information regarding Software AG product compatibility with IBM platforms and any IBM
requirements for Software AG products, please review the Product Compatibility for IBM Plat-
forms web page.

Before attempting to install this product, ensure that your host operating system is at the minimum
required level. For information on the operating system platform versions supported by Software
AG products, complete the following steps.

1. Access Software AG's Empower web site at https://empower.softwareag.com.

2. Log into Empower. Once you have logged in, you can expand Products & Documentation in
the left menu of the web page and select Product Version Availability to access the Product
Version Availability screen.

3. Use the fields on the top of this screen to filter its results for your Software AG product. When
you click the Search button, the supported Software AG products that meet the filter criteria
are listed in the table below the filter criteria.

This list provides, by supported operating system platform:
" the Software AG general availability (GA) date of the Software AG product;

Event Replicator Target Adapter Administration 19
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" the date the operating system platform is scheduled for retirement (OS Retirement);
® the Software AG end-of-maintenance (EOM) date for the product; and
* the Software AG end-of-sustained-support (EOSS) date for the product.

Note: Although it may be technically possible to run a new version of your Software AG

product on an older operating system, Software AG cannot continue to support operating
system versions that are no longer supported by the system’s provider. If you have questions
about support, or if you plan to install this product on a release, version, or type of operating
system other than one listed on the Product Version Availability screen described above,
consult Software AG technical support to determine whether support is possible, and under
what circumstances.

The Event Replicator Target Adapter Administration and the Event Replicator Target Adapter
Data Mapping Tool are not supported in AIX, HP-UX, Solaris or zLinux environments because
the Eclipse RCP port is not available in those environments. You will need to have a Windows or
Linux installation of the Administration Tool and Mapping Tool to use them. The Administration
Tool can remotely manage Event Replicator Target Adapter installations on those platforms where
the Eclipse RCP is not supported.

Supported Hardware

For general information regarding Software AG product compatibility with other platforms and
their requirements for Software AG products, visit Software AG's Hardware Supported web page.

Supported Browsers

For information on supported browsers, see the webMethods System Requirements documentation
on the Empower web site.

Supplied Third-Party Software

Event Replicator Target Adapter Administration uses Eclipse RCP Mars (version 4.5.2) and Eclipse
RCP DeltaPack (version 4.3.2). The Software AG Installer manages the installation of this third-
party software.

Note: If a third-party vendor drops support for a version of one of their products or even

for an entire product, Software AG automatically drops support for that version or product
as well.

20 Event Replicator Target Adapter Administration
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Installing Event Replicator Target Adapter Administration

Space Requirements

A minimum of 100 MB disk space (assuming all components are selected for installation) is required
to run all of the following products: Event Replicator Target Adapter Administration, Event Rep-
licator Target Adapter Data Mapping Tool, and the Event Replicator Target Adapter.

| Note: Additional space is needed to store log files. The amount of space needed depends

entirely on the level of logging you select.
Memory Requirements

At least 2GB system memory is required to run this software.

1024 MB or more random access memory (RAM) may be needed, depending on the size of your
transactions.

Windows Requirements

In Windows environments, be sure to install Microsoft Visual Studio 2008 Redistributable Package.
Firewall Requirements

If you attempt to install and use this software in a system with a firewall in place, be sure that
your system administrator has set up the firewall so that the component applications can access

the ports they need. For more information about port usage, read the Port Number Reference found
elsewhere in this documentation.

Prerequisite Products

This section describes prerequisite products for Event Replicator Target Adapter Administration.

= JRE Requirements
= X-Windows Graphical Environment Requirement

| Note: If a third-party vendor drops support for a version of one of their products or even

for an entire product, Software AG automatically drops support for that version or product
as well.
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JRE Requirements

The Software AG Installer installs the appropriate Java Runtime Environment (JRE) along with
its infrastructure. This JRE does not interfere with any other JRE that might already exist on the
same host machine on which Event Replicator Target Adapter Administration is installed.

X-Windows Graphical Environment Requirement

UNIX and LINUX installations require an X-Windows graphical environment to run the Admin-
istration Tool.

Before You Begin

Before you begin installing this product, ensure that the following prerequisites have been met:

1.

Software AG strongly recommends that you create an installation image of your existing Software
products and store the image on your internal network. You should create an image for each
operating system on which you plan to run the installation (for example, 32-bit, 64-bit, or both).
This will help you reduce WAN traffic and speed up installation and will ensure consistency
across installations over time, since the Software AG Installer provides only the latest release
of each product.

. Close (stop) all open applications, especially those applications interacting with or depending

on your Adabas databases. This includes Natural, Adabas Manager, the Adabas DBA Workbench,
and prior releases of any other Adabas products. To be on the safe side, also shut down all
Software AG services.

& Important: For some Software AG products, the Software AG Uninstaller will not be able

to remove key files that are locked by the operating system if the associated Software
AG products are not shut down.

Disable any antivirus software.
Ensure the target computer is connected to the network.

If this product requires a license key file, verify the license key file is copied somewhere in your
environment . Products requiring license key files will not run without valid license keys. For
more information, read The License Key, elsewhere in this section.

Verify your environment supports the system requirements for this product, as described in
System Requirements, elsewhere in this section.

22
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Installation Steps

Event Replicator Target Adapter Administration is installed using the Software AG Installer. It
does not require a license key.

You can download the Software AG Installer from the Software AG Empower website at litfps://em-
power.softwareag.com/.

This installation documentation provides a brief description on how to install the Event Replicator
Target Adapter Administration directly on the target machine using the installer wizard. For de-
tailed information on the installer wizard, read Using the Software AG Installer.

| Note: Read Using the Software AG Installer also if you want to use console mode, or if you

want to install using an installation script or installation image.

~ To install Event Replicator Target Adapter Administration, complete the following steps:

1  Start the Software AG Installer as described in Using the Software AG Installer.

2 When the first page of the Software AG Installer wizard (the Welcome panel) appears, choose
the Next button repeatedly, specifying all required information on the displayed panels, until
the panel containing the product selection tree appears.

All Adabas-related products (including Software AG Directory Server) can be selected for
installation within the Adabas Family product selection tree.

In addition to the Adabas Family product selection tree, two other trees, Event-Driven Archi-
tecture and Infrastructure (which includes the System Management Hub installation) are
available for installation. The Infrastructure tree must be selected for all Software AG products;
it provides the necessary Java runtime environment for the Software AG Installer as well as
Event Replicator Target Adapter Administration.

3  Toinstall Event Replicator Target Adapter Administration, select (check) the Event Replicator
Target Adapter Administration entry from the Adabas Family product selection tree.

4 Onthe License panel, read the license agreement and select the check box to agree to the terms
of the license agreement and then click Next to continue. If you do not accept the license
agreement, the installation will stop.

5  On the last panel, review the items you have selected for installation. If the list is correct,
choose the Next button to start the installation process.

After Event Replicator Target Adapter Administration has been installed, you will need to
manually start it. For more information, read Starting the Administration Tool under the section
entitled About the Event Replicator Target Adapter Administration Tool, elsewhere in this guide.
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Uninistallation Steps

You uninstall this product using the Software AG Uninstaller. For information on how to use the
uninstaller, read the Using the Software AG Installer guide.

Installing Fixes Using Software AG Update Manager

Event Replicator Target Adapter Administration is updated using the Software AG Update
Manager (SUM).

You can download the Software AG Update Manager from the Software AG Empower website
at https://empower.softwareag.com/.

This SUM installation documentation on Empower provides a brief description on how to update
Software AG products directly on the target machine using the Update Manager wizard. The SUM
documentation also includes instructions on how to apply updates in console mode or using
scripts.

~ To update Event Replicator Target Adapter Administration, complete the following steps:

1 Download and install Software AG Update Manager for your platform from Empower.

2 Shut down any running instances of the product. Updates cannot successfully apply if the
application is active.

3  From a console prompt in the SUM /bin directory, enter UpdateManagerGUI.bat
(UpdateManagerGUI.sh on UNIX/Linux).

4 On the opening page of the SUM tool, select Install Fixes from Empower, enter your SAG
product directory root location and provide your Empower User ID and password. Click
Next.

5 Expand through the Adabas Family product selection tree to find the entry for this product.

Tip: If the product is not shown in the tree, there is either no update available or the

product is not installed in the location you specified.

6  Select (check) the Event Replicator Target Adapter Administration entry in the product se-
lection tree. Click Next.

Tip: You can select more than one product to update before proceeding.
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The next screen presents a summary of products that are about to be updated. If any of them
require manual pre-installation steps, they will be highlighted in red and you will be directed
to read the update readme file for that product before proceeding.

Complete any pre-installation steps outlined in the readme file and check the box next to Pre-
installation steps have been completed. Click Next.

Note: If any pre-installation steps are required, the Next button will be unavailable

until you confirm these steps have been completed.

The tool will apply updates to all selected products and present you with a final screen con-
firming updates have been applied. Click Close to exit SUM or Home to return to the tool's
starting panel.

Uninstalling Fixes Using Software AG Update Manager

~ To remove an installed update, complete the following steps:

1
2
3
4

Shut down any running instances of the product.
Start Software AG Update Manager.
On the opening page, select Uninstall Fixes from the selection panel. Click Next.

If any product selected for uninstall requires manual steps, you will be directed to review the
update readme and confirm you have performed any pre-uninstallation steps. Click Next.

The fix(es) you selected for uninstall will be removed and the product(s) returned to their
previous state. Click Close to exit SUM or Home to return to the tool's starting panel.
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This chapter describes how to use the Event Replicator Target Adapter Administration. It covers
the following topics:

About the Event Replicator Target Adapter Administration Tool

This section describes how to start and stop the Event Replicator Target Adapter Administration
tool as well as the major features of the Event Replicator Target Adapter Administration tool in-
terface.

= Supported Platforms

= Starting the Administration Tool

= Shutting Down the Administration Tool

= The Main Window

= Accessing the Preferences Area

= Setting Configuration File and Preferences
= Tree View

= Menus

= Toolbar

= Getting Help

| Note: The Event Replicator Target Adapter must be stopped and restarted every time an

Event Replicator Target Adapter definition is saved or deleted using the Administration

tool. For this reason, we recommend that you shut down the Event Replicator Target Adapter
prior to making changes to the definitions and restart the Event Replicator Target Adapter
when all definition changes are complete. For information about stopping and starting the
Event Replicator Target Adapter, read Shutting Down the Event Replicator Target Adapter and
Starting the Event Replicator Target Adapter, in the Event Replicator Target Adapter User Guide.

Supported Platforms

Refer to the section Supported Operating System Platforms in Installing Event Replicator Target
Adapter Administration for details.

Starting the Administration Tool

The Administration tool runs in both Windows and UNIX environments.

~ To start the Administration tool in Windows using the Windows Start menu, complete the following steps:

1  From the Windows Start menu, select All Programs.

2 Select <installation-directory> where <installation-directory>isthename of the directory
in which you installed Event Replicator Target Adapter Administration. The default installation
directory is Software AG.
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Select Administration.

Select Event Replicator Target Adapter for Mainframe v. r, where v. r represent the version
and release number of the Event Replicator Target Adapter.

Select Start Administration.
The Administration tool starts up.

[\  Important: Before you can use the Administration tool, you must set preferences that

identify where the Event Replicator Target Adapter definitions should be stored, the
locations of the startup and shutdown commands for the Event Replicator Target Ad-
apter, and the location of the Event Replicator Target Adapter log files. For more in-
formation, read Setting Configuration File and Target Adapter Preferences, elsewhere
in this section.

~ To start the Administration tool in Windows using the administration.bat file, complete the following steps:

Navigate to the following directory: <installation-dir>/EventReplicatorTargetAdapterAd-
ministration/bin, where <installation-dir>is the name of the directory in which the Event
Replicator Target Adapter Administration program files were installed.

Run the administration.bat file.
The Administration tool starts up.

[\ Important: Before you can use the Administration tool, you must set preferences that

identify where the Event Replicator Target Adapter definitions should be stored, the
locations of the startup and shutdown commands for the Event Replicator Target Ad-
apter, and the location of the Event Replicator Target Adapter log files. For more in-
formation, read Setting Configuration File and Target Adapter Preferences, elsewhere
in this section.

~ To start the Administration tool in UNIX, complete the following steps:

1

Navigate to the following directory: <installation-dir>\bin, where <installation-dir>is the
name of the directory in which the Event Replicator Target Adapter Administration program
files were installed.

Sourece file sagenv.new to establish your environment variables by entering:

./sagenv.new

Run the administration.sh file.

The Administration tool starts up.
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[\  Important: Before you can use the Administration tool, you must set preferences that

identify where the Event Replicator Target Adapter definitions should be stored, the
locations of the startup and shutdown commands for the Event Replicator Target Ad-
apter, and the location of the Event Replicator Target Adapter log files. For more in-
formation, read Setting Configuration File and Target Adapter Preferences, elsewhere
in this section.

Shutting Down the Administration Tool

This section describes how to shut down the Administration tool in Windows environments. At
this time, the Administration tool only runs in Windows environments.

= Shutting Down the Administration Tool Window
= Shutting Down the Administration Tool from the Administration Tool

Shutting Down the Administration Tool Window

The simplest way of stopping the Administration tool is to shut down (kill) the window in which
it runs.

Shutting Down the Administration Tool from the Administration Tool

~ To shut down Event Replicator Target Adapter from the Administration tool:

m  Select the Exit command from the File menu.

The Administration Tool shuts down.
The Main Window

When you first start up the Administration tool, the main window displays.
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@ Event Replicator Target Adapter Administration - O X

Eile Run Window Help

@ Target Adapter

Accessing the Preferences Area

~ To access the preferences area of the Administration tool:

1  Start the Administration tool, as described in Starting the Administration Tool, elsewhere in
this guide.

The Administration tool main window appears.

2 Select the Preferences option from the Window menu.

The Preferences dialog appears. By default, the configuration file preferences are shown:
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@ Preferences o X
Adabas Analytics Collector MF M A

Adabas Analytics Collector MF

Available Adabas Analytics Collector MF environments
Target Adapters

Name Type Add...

Apply and Close Cancel

3  Modity the Target Adapter environments with the commands described in the following
table, if necessary:

Command Description

Add Add an existing Target Adapter environment to the Administration
control.

Edit Edit the Target Adapter properties.

Delete Delete the Target Adapter environment from the Administration
control.
Note: This does not delete the Target Adapter installation.

Tip: The order of the Target Adapter environments in the Preferences Tree View is the same as in

this list. With the following commands you can control the order.

Up Move Target Adapter one position up in the Preferences Tree View.
Down Move Target Adapter one position down in the Preferences Tree
View.

4  Modify the Adabas Analytics Collector MF environments with the commands described in
the following table, if necessary:
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Command Description

Add Add an existing Adabas Analytics Collector MF environment to the
Administration control.

Edit Edit the Adabas Analytics Collector MF properties.

Delete Delete the Adabas Analytics Collector MF environment from the

Administration control.

Note: This does not delete the Adabas Analytics Collector MF

installation.

Tip: The order of the Adabas Analytics Collector MF environments in the Preferences Tree View is

the same as in this list. With the following commands you can control the order.

Up Move Adabas Analytics Collector MF one position up in the
Preferences Tree View.

Down Move Adabas Analytics Collector MF one position down in the
Preferences Tree View.

Setting Configuration File and Preferences

The configuration file preferences identify, among other things, the location of the configuration
files used by the Event Replicator Target Adapter and Adabas Analytics Collector MF you will
set up using the Administration tool. The Target Adapter preferences identify the locations of the
Event Replicator Target Adapter startup and shutdown commands as well as the location of its
log files; the Adabas Analytics Collector MF preferences identify the location of its configuration
file.

Note: Event Replicator Target Adapter Administration cannot start and stop the collector,

only set its configuration.
If the configuration file preferences are not supplied, you cannot set the preferences.

@ Caution: We do not recommend that you alter Event Replicator Target Adapter definitions

in the context.xml file using a text editor or any editor other than the Event Replicator Target
Adapter Administration tool. If you do, errors may result.

~ To set configuration file and Target Adapter preferences:

1 Access the preferences area, as described in Accessing the Preferences Area, elsewhere in this
guide.
The Preferences dialog appears.

2 Select Target Adapter on the left side of the Preferences dialog.

3 Select the Target Adapter environment.
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4  Click on the Edit... button.

The preferences appear on the Edit Target Adapter pop-up dialog.

@, Edit Target Adapter O x |

Edit the Target Adapter environment

Edit the Target Adapter environment by changing the name or the properties

Marme: | hocal Target Adapter

Rermote Target Adapter
[ Remote
Update

Software AG ERTA Administration Service
Port: | 3004
[] Automatically Start and Stop Target Adapter

Target Adapter Location
Root Directory: | CA\Users\ger\product\art\EventReplicatorTargetidapter | Browse...

Log File Directory: | C\Users\ger\product\art\EventReplicatorTargetAdapteriart\datallogs |.Br0wseu.

IMX Port: | 4000
User Targets
MName Begister...

Deregister

Backup Configuration File

®) No Backup

O Backup
Show Warning Dialog when Configuration changed while Target Adapter is active
Scroll to end of log file when editor is opened or refreshed

Version: | 3.7 v
Validate Settings Cancel

5 Modify the preferences as described in the following table, if necessary:
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Preference Description

Name Name of the Target Adapter environment that is displayed in the Tree View.

Remote Target Adapter

Remote Check this option when the Target Adapter environment is on the remote host, or if
on the local machine but in a different installation suite location than the tool.

Host Name of the remote host.

Update This command updates the Target Adapter Location according to what is found by
the ERTA Administration Service.

ERTA Administration Service

Port Specify the port number of the ERTA Administration Service. The default is 3004.
Note: When using the Administration tool to administer a remote Event Replicator
Target Adapter installation, specify the ERTA Administration Service Port number
and the host name (Host field) in the appropriate fields. Clicking on Update will cause
Administration to attempt to contact the remote ERTA Administration Service or
Daemon to discover details about the installation and fill in the Root Directory and
Log File Directory paths with the appropriate information.

Automatically |Indicate whether or not the Event Replicator Target Adapter should be automatically

Start and Stop |started and stopped by the ERTA Administration Services. Check this box if you want

Target Adapter |it to be automatically started; leave this box unchecked if you do not.

via ERTA

Administration |Note: On Windows systems, if Event Replicator Target Adapter Administration is

Services used to manually start the Target Adapter, it will by default be running in the context
of the logged in user and not under the ERTA Administration Service’s System user.
If started this way, when the user logs out, the Target Adapter will stop. In order for
the Target Adapter to truly be running as a service, you must start it by starting or
restarting the ERTA Administration Service, which will start the Target Adapter under
the System user context. A workaround for this is to configure the local Target Adapter
as "Remote". This will cause the ERTA Administration Service to be called first to start
the Target Adapter even when started using the Administration tool. Note there will
be no local console opened when the Target Adapter is running in this way.

Target Adapter Location

Root Directory |Specify the fully-qualified path to the root directory of the Target Adapter environment.
The initial value in this field is determined using the path of the ERTA Administration
Service identified by the Host and ERTA Administration Service Port fields and then
applying the default installation location of the log files to that path when the Update
button is pressed. Change this path as necessary for your installation.

Log File The fully-qualified path of the location of the Event Replicator Target Adapter log

Directory files. The initial value in this field is determined using the path of the ERTA
Administration Service identified by the Host and ERTA Administration Service
Port fields and then applying the default installation location of the log files to that
path. Change this path as necessary for your installation.

JMX Port Specify the port number that should be used for communication between the Tomcat

server and the Administration tool via JMX. This port number should match the port
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Preference Description
number you specified for JMX communication during the Event Replicator Target
Adapter installation. The default is 4000.
User Targets | This table lists all registered User Targets.
With the Register button you can register new User Targets by selecting the jar that
implements the User Target interface.
@, Register User Target X
Register an New User Target
Register an User Target to the Target Adapter by selecting the jar file
File: | C\Users\git\art-demao\buildinstalhdemolart-demo-3.7 jar | Browse... |
Found User Target: Demo.
OK Cancel
After you register it, the new target is available on the Target Adapter tree view.
With the deregister button you can deregister User Targets from the Target Adapter.
Backup Indicate whether or not the Event Replicator Target Adapter configuration file
Configuration |(context.xml) should be backed up whenever changes are made to the Administration
File tool. Select the Backup radio button to request the backup; select the No Backup
radio button to suppress the backup.
Show Warning |Indicate whether or not the warning dialog should be displayed when your
Dialog when |configuration is changed and the Event Replicator Target Adapter is running.
Configuration
changed while
Target Adapter
isup
Scroll to End of |When this check box is checked, the log file will be opened at the end of the log file
Log file when |(showing the latest logged activity) when the Editor is opened or refreshed. When
Editor is this check box is not checked, the log file will automatically open at the top of the file
opened or (showing the earliest logged activity in that log file).
refreshed
Version Set the version of the Target Adapter environment.

Click Validate Setting to validate the Target Adapter settings:
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@ Validate Settings a X
Description Result
Validate Start Script Location Valid.
Validate Stop Script Location Valid.
Validate Log Directory Valid.
Validate JMX Port s Not valid JMX Server found. This is okay, if the Target Adapter is down.

7  Click OK to apply the updates and close the Preferences dialog. No validation is performed;
you should validate settings before closing.

Click Cancel to close the Preferences dialog without update

~ To set configuration file and Adabas Analytics Collector MF preferences:

1 Access the preferences area, as described in Accessing the Preferences Area, elsewhere in this
guide.

The Preferences dialog appears.

2  Click on the Add... button.

The preferences appear on the Add an Adabas Analytics Collector MF pop-up dialog.
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@ Add Adabas Analytics Collector MF a X

Add an Adabas Analytics Collector MF environment

"y Enter the name for the Adabas Analytics Collector MF environment,

Name: | |

Remote Adabas Analytics Collector MF

[JRemote

Adabas Analytics Collector MF Location

Root Directory:

Browse...

Validate Settings OK Cancel

3 Modity the preferences as described in the following table, if necessary:

Preference

Description

Name

Name of the Adabas Analytics Collector MF environment that is displayed
in the Tree View.

Remote Adabas Analytics Collector MF

Remote Check this option when the Adabas Analytics Collector MF environment is
on the remote host, or if on the local machine but in a different installation
suite location than the tool.

Host Name of the remote host.

Adabas Administration
Service Port

Specify the port number of the ERTA Administration Service. The default
is 3004.

Root Directory

Specity the fully-qualified path to the root directory of the Adabas Analytics
Collector MF environment. If the Adabas Analytics Collector MF installation
is local, you can use the Browse button to find the root. If the installation is
remote, Browse is disabled and you have to manually enter the fully qualified
path to the product installation root. Change this path as necessary for your
installation.

4  Click Validate Setting to validate the Adabas Analytics Collector MF settings:
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@ Validate Settings O X

Description Result
Validate Configuration File Loca.. Valid.

5 Click OK to apply the updates and close the Preferences dialog. No validation is performed;
you should validate settings before closing.

Click Cancel to close the Preferences dialog without update
Tree View

Each Target Adapter and Adabas Analytics Collector MF node appears in the tree view under the
corresponding parent node:

@ Event Replicator Target Adapter Administration E@Iﬁ

[File Run Window Help

4 @ Target Adapter = B8
@r Local Target Adapter

4 |'§ Adabas Analytics Collector MF
.G EAP

The current status of Target Adapter nodes are indicated by an icon.

The icons are described in the following table:
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The Target Adapter is running.

The Target Adapter is coming up.

=2
@|The Target Adapter is stopped.
&
0

The Target Adapter is going down.

| Checking the state of the Target Adapter.

@ | The Target Adapter has an error. Perform Validate Setting in the Preferences to check for a cause.

Note: The display only shows the running status of Target Adapter instances. It does not

show the status of any Adabas Analytics Collector MF instances, only the configuration file
settings.

Menus

The Administration tool main window has four menus. The commands on each menu are described
in the following table:

Menu Menu Item Description
(Command)
File New The New submenu depends on the selected node.

The following is applicable for a Target Adapter Node.

Allows you to create a new definition. When you select the New command,
a submenu appears from which you can select the type of definition you
would like to create:

= Database Target: Select this option to create anew RDBMS database target
definition for the Event Replicator Target Adapter.

= EntireX Communicator Source: Select this option to create a new
webMethods EntireX source definition for the Event Replicator Target
Adapter.

= Filter: Select this option to a create a new filter definition for the Event
Replicator Target Adapter

= JMS Target: Select this option to a create a new JMS target definition for
the Event Replicator Target Adapter

= Terracotta Target: Select this option to create a new Terracotta target
definition for the Event Replicator Target Adapter.

u Terracotta Merge Target: Select this option to create a new Terracotta
Merge target definition for the Event Replicator Target Adapter.

= Target Database Option: Select this option to create a option definition
for the target databases you have defined to Event Replicator Target
Adapter.

" Web Service Target: Select this option to create a new web service target
definition for the Event Replicator Target Adapter.
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Menu Menu Item Description

(Command)

® WebSphere MQ Source: Select this option to create a new WebSphere
MQ source definition for the Event Replicator Target Adapter.

The following is applicable for an Adabas Analytics Collector MF Node.

= Elasticsearch Target: Select this option to create a new Elasticsearch target
definition for the Adabas Analytics Collector MF.

® EntireX Communicator Source: Select this option to create a new
webMethods EntireX source definition for the Adabas Analytics Collector
ME.

= WebSphere MQ Source: Select this option to create a new WebSphere
MQ source definition for the Adabas Analytics Collector MF.

= Target Adapter Source: Select this option to create a new Target Adapter
source definition for the Adabas Analytics Collector MF.

Close Allows you to close the definition you have currently selected in the
Administration tool. If the definition has not been saved, you will be
prompted to save it.

Close All Allows you to close all open definitions in the Administration tool. If any
definition has not been saved, you are prompted to save them.

Open File Allows you to open an existing definition in the Administration tool.

Save Saves the definition you have currently selected in the Administration tool.
If no name has been specified for a new definition, you are prompted for
one. You can also click the L5t button on the toolbar to do this.

Save All Saves all the definitions you currently have open in the Administration tool.
If a name has not been specified for one or more definition, you are prompted
for them. You can also click the %_-;] button on the toolbar to do this.

Refresh Refreshes the definitions in the Administration tool, based on the definitions
stored in the currently saved configuration file. You can also press the F5
key to refresh the definitions.

Exit Shuts down the Administration tool.

Run Start Target ) ) =

Adapter Starts the Event Replicator Target Adapter. You can also click the button

Only on the toolbar to do this.

applicable Stop Target ]

for Target | A dapter Stops the Event Replicator Target Adapter. You can also click the button
Adapter on the toolbar to do this.

nodes Restart Target  |Stops and restarts the Event Replicator Target Adapter. You can also click

Adapter L
the & button on the toolbar to do this.

Window |Preferences Allows you to set configuration file and target adapter preferences for the

Administration tool.
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Menu Menu Item Description
(Command)
Help Help Contents  |Gives you access to the online help system shipped with the Administration
tool.
Search Allows you to search the online help system shipped with the Administration
tool.
About Event Displays information about the Administration tool you have installed.
Replicator Target
Adapter
Administration
Toolbar

The Administration tool main window has four buttons on its toolbar. The buttons are described
in the following table:

Button

Description

=

Saves the definition you have currently selected in the Administration tool. If no name has been
specified for a new definition, you are prompted for one. You can also select the Save command on
the File menu to do this.

£

Saves all the definitions you currently have open in the Administration tool. If a name has not been
specified for one or more definition, you are prompted for them. You can also select the Save All
command on the File menu to do this.

Starts the Event Replicator Target Adapter. You can also select the Start Target Adapter command
on the Run menu to do this.

Stops the Event Replicator Target Adapter. You can also select the Stop Target Adapter command
on the Run menu to do this.

G| | W

Stops and restarts the Event Replicator Target Adapter. You can also select the Restart Target
Adapter command on the Run menu to do this.

Getting Help

The Administration tool help through the Help menu. In addition, you can get information about
the version of the Administration tool you have installed by selecting the About Target Adapter
Administration option on the Help menu.

= Using Tool Tip Help
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= Getting Help from the Help Menu
Using Tool Tip Help

Tool tip help is available for some items within the Administration tool, including toolbar buttons
and menu items.

To use tool tip help, simply allow your mouse cursor to rest momentarily over an item for which
you would like help. For example, resting the mouse cursor over a toolbar button will display a
tool tip that describes a button.

Getting Help from the Help Menu
Click Help Contents option on the Help menu to access the online help for the Administration

tool. A browser opens to the documentation overview screen, allowing you to browse help by
topic or search for a specific help topic by clicking Search.

Activating Your Event Replicator Target Adapter or Adabas Analytics Collector
MF License

WithEvent Replicator Target Adapter, a license key is not required during installation. Further,
since licenses are target specific, you may have been provided with more than one license key file,
depending on the terms of your license. With the Event Replicator Target Adapter Administration
you can manage your license keys.

) Notes:

1. If you are using Event Replicator Target Adapter Administration to administer a remote instance
of Event Replicator Target Adapter, the license you are activating must be on a file system ac-
cessible to your Event Replicator Target Adapter Administration installation. The tool will send
the license to the remote Event Replicator Target Adapter installation where it will be saved
locally on that machine.

2. The same rules and procedures apply for the Adabas Analytics Collector MF.
= Accessing the Licensing Configuration Screens

= Adding New Licenses
= \iewing License Key Details
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= Deleting Licenses

Accessing the Licensing Configuration Screens

Right click on the appropriate Target Adapter node and select the item License Keys:

@, Event Replicator Target Adapter Administration - O *
File Run Window Help
> =
~ @ Target Adapter = B8
> @ Local Tarnet Adanter
License Keys
& Refresh F5
Properties
Target Adapter 'Local Target Adapter’ is inactive, H
The following dialog is displayed:
@, Available License Keys X
Name Code  Version Operating System Expiration Date Add..
Details...
Delete
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Adding New Licenses

> To add new licenses

1 Click on the “Add...” button

2 Browse to the location where you have stored your license key(s)

3  Select the license file(s) you want to add and click “Open”

The following screen appears:

-
@ Add a License file

Q—? System (C:)
= Data ([)

2

L |

[

at
=] adabd.xml

Q\:’} | . » Computer » Data(D:) » Licenses 7 |‘f | | Search Licenses L
Organize ~ New folder =~ 0 @
S Eavorites * Mame . Date modified Type

Bl Desktop = 0000026136 _arttc30.xml 02.07.2015 10:08 XML Decument
4 Downloads =] 0000026137 _arttc30.xml 02.07.2015 10:30 XML Docurmnent
= Recent Places = 0000026138 _art30.ml 03.07.201513:16 XML Document
E = 0000026956 _art30.xml 03.11.2015 16:53 XML Document
- Libraries = 0000026992 _art31.xml 2011.2015 14:35 XML Document
@ Documents =] 0000026994 _art31.xml 2011.2015 15:27 XML Decument
J1 Music | 0000026995_art31.xml 2011.2015 15:28 XML Document
[&5 Pictures i | 0000026996 _art31.xml 2011.2015 15:29 XML Document
[ Subversion = 0000027390 _art31.xml 03.02.2016 10:52 XML Decument
E Videos =] 0000250481 _PrestoLicensed9.xml 0510.2015 21:47 XML Document
=] 0000250584_UniversalMessaging_Integrat.. 05102015 23:01 XML Document
/M Computer =] adaB3_win_single_userxml 1511.2011 09:39 AML Document

02.10.2013 07:54

XML Decument

1L}

| 3

File name:  "0000027390_art31.xml" "0000026994_art31.xml” "0000026995_art31.xml" "0000026¢ + [*-Xml

o

| | concel |

Note: It is possible to select more than one license key file at a time!

-
@ Available License Keys

MName

Event Replicator Target Adapter
Target Adapter for Analytics
Target Adapter for Oracle
Target Adapter for Progress
Target Adapter for Terracotta

Code
ART
ARTAM
ARTOR
ARTPG
ARTTC

Version
31
31
31
31
31

Operating System
win7_pro, wing, winl0
win7_pro, wing, winl0
YK

w2008,w2012

win/_prao, wing, winl0

Expiration Date
Unlimited
Unlimited
Unlimited
Unlimited
Unlimited

Details...

Delete
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Viewing License Key Details

To view the details of an activated license, select the license you want to view and press the “De-

tails...” button:

The following screen appears:

r

G License Details

Event Replicator Target Adapter

Licenze Details

Serial Mumber:

License Key:

Custormer ID: 1

Custorner Mame:  Software AG

Product Code: ART
Product Version: 3.1
Expiration Date:  Unlimited

Operating System: win?_pro, wing, winl(
Product Mame:  Event Replicator Target Adapter

License File: D SoftwareAG_ART30MEventReplicatorT argetAdapterAdministrationbin'. . \commontconfiart3l xml I

Deleting Licenses

~ To delete license keys:

= Select the license(s) to be deleted and press the “Delete” button:

The following screen appears:

@ Available License Keys

MName Code Version  Operating System Expiration Date
Event Replicator Target Adapter ART 31 win7_pro, wing, winl0 Unlimited
Target Adapter for Analytics ARTAM 31 win7_pro, wing, winl0 Unlimited
Target Adapter for Oracle ARTOR 31 YK Unlimited
Target Adapter for Progress ARTPG EN w2008,w2012 Unlimited

i Target Adapter for Terracotta ARTTC 31 win/_pro, wing, winl0 Unlimited

Add...
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and confirm your decision to delete your selected license key(s):

' |
@ Question LJ&

O Areyou sure you want to delete these 4 license keys?

Target Adapter for Analytics
Target Adapter for Oracle
Target Adapter for Progress
Target Adapter for Terracotta

Maintaining the Event Replicator Target Adapter Engine Configuration

| Note: Changes you make to the engine configuration require that the Event Replicator

Target Adapter be restarted. For information about restarting the Event Replicator Target
Adapter, read Restarting the Event Replicator Target Adapter, in the Event Replicator Target
Adapter User Guide.

~ To modify the Event Replicator Target Adapter engine configuration, complete the following steps:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Configurations section.
The Event Replicator Target Adapter engine and Repository configurations are listed under
Configurations.

3  Double-click on Engine .

The Engine Configuration panel appears on the right side of the window, as shown below:
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@, Event Replicator Target Adapter Administration

Eile Run Window Help
P
~ @ Target Adapter
~ @ Local Target Adapter
~ % Configuration File

i Engine Configuration [Local Target Adapter] &2

Description: . Engine

~ i Configurations Service URL:
=4 Engine Options
% Repository XML Splitter Thread
3 Filter [] Commit Unprocessed Message
 Sources [] Transaction Cache
03 Target Database Options
@ Targets Parameters
@, Target Adapter Threads: | 1 |
Retry Count: | L |
Retry Interval: | 30s |
XML Capture
[] XML Capture
Directcry:| ATargetAdapter\xmlcapture | | Browse...
Target Adapter 'Local Target Adapter’ is inactive. H

4  Verity and update the values on the Engine Configuration panel, as described in the following
table:

Field Name Description

Description Specify a description for the database option definition.

Service URL Specify the URL that identifies the location of the database processing used by the
Event Replicator Target Adapter. The format of this URL is:
http://hostname:port/sqlrep/services/AdabasReptorPort
The hostname and the port number are the only things that should be changed
in this URL format. The hostname specified must be fully-qualified (for example
"myhost.mycompany.com").

Note: If you leave this field blank, the Event Replicator Target Adapter will properly
determine and construct the value for this parameter.

XML Splitter Select this option (check it) to indicate that an additional thread should be used by

Thread the engine to improve throughput.

When you select this option, the additional thread is used; if you do not select this
option, it is not. In general, we recommend that you select this option.

Commit Select this option (check it) to indicate that unprocessed messages should be

Unprocessed committed. The default is to leave this option unchecked (unselected). Selecting

Message this option will allow the Event Replicator Target Adapter to continue running if
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Field Name

Description

an invalid message is received but includes the possibility of data inconsistency
issues between Adabas and the target RDBMS.

Transaction
Cache

Select this option (check it) to activate transaction caching. With this option checked,
the Event Replicator Target Adapter will keep a cached record of all transactions
processed to the target(s), and subsequently compare all incoming transactions to
those already processed, avoiding duplicate transaction. This situation would likely
only occur if there has been some communication outage with the Event Replicator
Target Adapter’s source during the small window in between a transaction being
committed at the target but not yet committed (removed) from the source.

The use of this option will have a negative impact on performance. Therefore we
recommend keeping this unchecked (the default) unless the user is trying to work
around a specific error or circumstance.

Threads

Specify how many engine threads should be run. Specifying one engine thread for
every replicated data source defined to the Event Replicator Target Adapter can
improve performance. However, defining more than one thread for every data
source is not necessary.

Retry Count

Specify the number of times that the Event Replicator Target Adapter engine should
attempt to communicate with the target if communication errors occur. The default
is "3" times.

Retry Interval

Specify the number of seconds the Event Replicator Target Adapter engine should
wait between attempts to communicate with the target if communication errors
occur. The default is "30" seconds.

XML Capture

Select this option (check it) to indicate that you want the XML documents received
from the Event Replicator Server written (in a readable form) to the directory
specified by the Directory field.

When you select this option, the XML documents are written; if you do not select
this option, they are not.

Directory

Specify the fully-qualified path of the directory in which XML documents received
from the Event Replicator Server should be written when the XML Capture option
is turned on (checked). If available, use the Browse button to locate and select the
directory (when the Event Replicator Target Adapter is installed remotely, the
Browse button is not available).

Once all fields have been specified satisfactorily, click the Save button (L5) on the toolbar to

save the engine configuration.

Or:

Select the Save command on the File menu of the Administration tool.

The configuration is saved in the context file for the Event Replicator Target Adapter.
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Maintaining the Event Replicator Target Adapter Repository Configuration

The Event Replicator Target Adapter repository is used as a persistent store to save:

® information sent to it by the Event Replicator Server
= generated XSLT files.

Using the Event Replicator Target Adapter Administration tool, you can maintain the settings for
the persistent store.

Note: Changes you make to the repository configuration require that the Event Replicator

Target Adapter be restarted. For information about restarting the Event Replicator Target
Adapter, read Restarting the Event Replicator Target Adapter, in the Event Replicator Target
Adapter User Guide.

~ To modify the repository (persistent store) configuration, complete the following steps:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Configurations section.
The Event Replicator Target Adapter engine and repository configurations are listed under
Configurations.

3 Double-click on Repository .

The WebDAV Configuration panel appears on the right side of the window, as shown below:
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@, Event Replicator Target Adapter Administration - O X
Eile Run Window Help

B
~ @ Target Adapter i~ Repository Configuration [Local Target Adapter] 2 =0

v @ Local Target Adapter
~ [ Configuration File

Description: | Webdav-Config

v w1 Configurations URL: | |
o Engine Collection: | ADABASReplicator/ |
. &= Repasitary Cache Size: |20 |
w Filter
B Sources Note: Changes to this Configuration may require a Restart of the Replication Server.

o3 Target Database Options
Targets
&, Target Adapter

Target Adapter 'Local Target Adapter’ is inactive. H

Verify and update the values on the WebDAV Configuration panel, as described in the fol-

lowing table:

Field Name

Description

Description

Specify a description for the repository configuration. This setting does not affect the
execution of the Event Replicator Target Adapter.

URL

Specify the URL that identifies the location of the repository used by the Event Replicator
Target Adapter. The format of this field is

http://hostname:port/webdav/

The hostname and the port number are the only things that should be changed in this
URL format. The hostname specified must be fully-qualified (for example
"myhost.mycompany.com").

Note: We recommend that the WebDAV repository reside within the same Tomcat
instance as the Event Replicator Target Adapter.

Collection

Specify the repository collection name that should be used for the persistent store.

Cache Size

Specify the number of files that should be internally cached to avoid reading files from
the repository. For optimal performance, this value will depend on how many files are
being replicated. You may want this value set to a slightly greater value than the actual
number of files being replicated, to allow for internal files that might be read. The default
is 20.
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Once all fields have been specified satisfactorily, click the Save button (EBH) on the toolbar to
save the WebDAV configuration.

Or:
Select the Save command on the File menu of the Administration tool.

| Note: Changes to this configuration may require a restart of the Event Replicator Target

Adapter. For more information, read Restarting the Event Replicator Target Adapter, in
the Event Replicator Target Adapter User Guide.

The configuration is saved in the context file for the Event Replicator Target Adapter.

Configuring Target Definitions for Event Replicator Target Adapter

The Event Replicator Target Adapter supports several types of targets to which replicated data
can be submitted: J]MS, RDBMS databases, Adabas, Terracotta (caches and database server) and
web services. Before you can use the Event Replicator Target Adapter, you must set up a target
definition for every unique target you intend to use for the replicated data the Event Replicator
Target Adapter processes. These definitions provide Event Replicator Target Adapter with the
information it needs to access your target and to communicate with Event Replicator for Adabas
via webMethods EntireX or WebSphere MQ.

= Maintaining RDBMS Database Target Definitions
= Maintaining JMS Target Definitions

= Maintaining BigMemory Max and BigMemory Max Merge Target Definitions
= Maintaining Web Service Target Definitions

= Maintaining Adabas Target Definitions

= Maintaining Adabas (Binary) Target Definitions

= Maintaining Terracotta Target Definitions

= Maintaining Apama Target Definitions

= Modifying Existing Target Definitions

= Renaming Existing Target Definitions

= Deleting Existing Target Definitions

‘J Notes:

1. User authorization to maintain any new RDBMS tables via Event Replicator Target Adapter is
inherited from the site's privilege settings for the database. Authorization is managed by the
user's RDBMS privileges and not by Event Replicator Target Adapter. Event Replicator Target
Adapter will no longer grant RDBMS privileges to the user. Therefore, if you want to use Event
Replicator Target Adapter to maintain tables in an RDBMS, verify that your RDBMS authoriz-
ation privileges are correct for the maintenance you want to perform.
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2. You will need to restart the Event Replicator Target Adapter to fully process any additions or
changes made to Event Replicator Target Adapter configuration definitions in the Administration
tool. For more information, read Restarting the Event Replicator Target Adapter, in the Event Rep-
licator Target Adapter User Guide.

Maintaining RDBMS Database Target Definitions

You must define target definitions for each unique RDBMS database you intend to use with the
Event Replicator Target Adapter prior to using Event Replicator Target Adapter. These definitions
will provide Event Replicator Target Adapter with the information it needs to access your RDBMS
and to communicate with Event Replicator for Adabas via webMethods EntireX or WebSphere

MQ.

| Note: Do not copy the context.xml, server.xml, or any configuration file from an older install-

ation and expect it to work for this installation. Errors will result if you try this.

~ To define a target definition for an RDBMS database:

1  Make sure you have completed all of the installation instructions specific to your RDBMS, as
described in one of the following sections, in the Event Replicator Target Adapter Installation
Guide:

* Installation Considerations for DB2

® Installation Considerations for DB2 on z/OS

* Installation Considerations for Microsoft SQL Server
* Installation Considerations for MySQL

* Installation Considerations for Oracle

= Installation Considerations for PostgreSQL

* Installation Considerations for Teradata

2 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

3 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

4  Right-click on the Databases categorization and select New from the drop-down menu.

Or:
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Select the New command from the File menu and then Database Target from the resulting

submenu.

An untitled RDBMS database definition panel appears on the right side of the Administration

tool window, as shown below:

@ Event Replicator Target Adapter Administra

File RBun Window Help
LI
~ @ Target Adapter
~ @ Local Target Adapter
~ [ Configuration File
v %I Configurations
=3 Engine
=" Repository
3 Filter
 Sources
» 03 Target Database Options
w Targets
2 Adabas
£ Adabas (Binary)
~ @ Apama
& Apama
=" BigMemory Max
58 BigMemory Max Merge
0 Database
22, IMS
» @ Terracotta
A Web Service
> @, Target Adapter

Target Adapter ‘Local Target Adapter’ is inactive.

tion

0 *Untitled 9 [Local Target Adapter] &

Data Source URL: |jdb-:'sq|sewem'/4h

ost>:<port>;DatabaseName= <databasename> |

RDBMS Target Type: M
User
Name: |

Password: I

Connection

Max Active: | 100

Max. Idle: | 100
Max. Wait: [ 30000

Validation Query: | select 1

5  Supply valid values for the RDBMS database installed at your site. The database fields are

described here.

Data Source URL

Use this parameter to identify the fully qualified URL of the RDBMS database that should
be used by Event Replicator Target Adapter.

J Note: The first database type shown in the RDBMS Target Type field affects the
template shown in the Data Source URL field.

The following table provides the URL format that should be used for the different relational

databases supported by Event Replicator Target Adapter:
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RDBNS Type

Data Source URL Format

DB2

Jdbc:db2://hostname:port/instance

Replace hostname with the name of the host machine on which DB2 is installed, port with
the DB2 listening port (the default is 50000), and 7nstance with the case-sensitive name
of the DB2 database instance you created in the installation steps for DB2 (read Installation
Considerations for DB2 in the Event Replicator Target Adapter Installation Guide).

DB2 on
z/OS

jdbc:db2://hostname: port/instance

Replace hostname with the name of the host machine on which DB2 for z/OS is installed,
port with the DB2 for z/OS listening port, and 7nstance with the case-sensitive name of
the DB2 database instance you created in the installation steps for DB2 for z/OS (read
Installation Considerations for DB2 on z/OS in the Event Replicator larget Adapter Installation
Guide).

Microsoft
SQL Server

jdbc:sqlserver://hostname:port;DatabaseName=dbname

Replace hostname with the name of the host machine on which Microsoft SQL Server is
installed, port with the SQL Server listening port (the default is 1433), and dbname with
the case-sensitive name of the Event Replicator Target Adapter database you created in
the installation steps for Microsoft SQL Server (read Installation Considerations for Microsoft
SQL Server in the Event Replicator Target Adapter Installation Guide).

Note: Note that named SQL Server instances are allowed and supported. Every instance

(named or default) must run on a different port. With Event Replicator Target Adapter 2.7
hotfix 3 and later releases, when you specify an instance name, it takes precedence over
any port number you might also supply; with earlier releases of the Event Replicator Target
Adapter, the port number takes precedence over the instance name. If neither an instance
name or port number is provided, the default port 1433 will be assumed. According to
Microsoft, however, optimal performance is obtained by specifying the port number without
the instance name. See Microsoft connection URL documentation
https://docs.microsoft.com/en-us/sql/connect/jdbc/building-the-connection-url for details.
So the safest and fastest way to specify the URL for named instances that will work even
using the bulk loader is using the hostname:port syntax.

MySQL

Jjdbc:mysql://hostname:port/instance

Replace hostname with the name of the host machine on which MySQL is installed, port
with the MySQL listening port (the default is 3306), and 7nstance with the case-sensitive
name of the MySQL database instance you created in the installation steps for MySQL
(read Installation Considerations for MySQL in the Event Replicator Target Adapter Installation
Guide).

Oracle

jdbc:oracle:thin:@hostname: port:instance

Replace hostname with the name of the host machine on which Oracle is installed, port
with the port number for the database (the default is 1521), and 7nstance with the Oracle
database instance name you created in the installation steps for Oracle (read Installation
Considerations for Oracle in the Event Replicator Target Adapter Installation Guide).
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RDBNS Type

Data Source URL Format

PostgreSQL

Jjdbc:postgresql://hostname: port/database-name
jdbc:postgresql://hostname:port/databasename

Replace hostname with the name of the host machine on which PostgreSQL is installed,
port with the PostgreSQL listening port (the default is 5432), and database-name with
the case-sensitive name of the PostgreSQL database you created in the installation steps
for PostgreSQL (read Installation Considerations for PostgreSQL in the Event Replicator Target
Adapter Installation Guide).

Teradata

jdbc:teradata://hostname/DATABASE=dbname,DBS_PORT=port[,CHARSET=utf8]

Replace hostname with the name of the host machine on which Teradata is installed,
dbname with the name of the Teradata database catalog you want to use, and port with
the Teradata listening port (read Installation Considerations for Teradata in the Event Replicator
Target Adapter Installation Guide).

Optionally, if you have applied an Event Replicator Target Adapter hot fix that provides
support for UTF-8 characters in Teradata databases, you can specify the "CHARSET=ut{8"
parameter to indicate that you will be loading UTF-8 data to the database. For more
information about the hot fixes that support this, refer to the README file provided with
Event Replicator Target Adapter.

RDBMS Target

Type

Identifies the type of the RDBMS. The following table provides the driver class value that
should be used for the different relational databases supported by Event Replicator Target

Adapter:

RDBMS Type Driver Class Value

DB2 com.ibm.db2.jcc.DB2Driver
DB2 on z/OS com.ibm.db2.jcc.DB2Driver

Microsoft SQL Server|com.microsoft.sqlserver.jdbc.SQLServerDriver

MySQL com.mysql.jdbc.Driver
Oracle oracle.jdbc.driver.OracleDriver
PostgreSQL org.postgresql.Driver <«
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RDBMS Type Driver Class Value

Teradata com.ncr.teradata.TeraDriver <

Note: Teradata RDBMS versions prior to version 12 will no longer be

supported in future versions of the Event Replicator Target Adapter.

Name
Specify a user name with authorization to access the database.

Password
Specify the password associated with the user name.

6  Supply the connection parameters:

Max. Active
Specify the maximum number of active connections provided by the connection pool.
Enter the number of maximum anticipated concurrent connections to the target. As a
guide, you should enter a number equivalent to the number of Event Replicator sources
that may at any one time be providing replicated data to this target.

Max. Idle
Specity the maximum number of idle connections in the connection pool. Usually this
number is set to the same as Max. Active.

Max. Wait
Specify the time (in milliseconds) that Event Replicator will wait for an available connection
from the connection pool.

Validation Query
The SQL query used to validate the connection. The default is determined by the target
type. We recommend not changing this value from the default.

Once all fields have been specified satisfactorily, click the Save button (L5)) on the toolbar to
save the target database definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
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Maintaining JMS Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to a JMS topic or queue managed by a JMS provider that supports the "Java Naming
and Directory Interface" (JNDI). To do this, you must create a target definition for each unique
JMS topic or queue with which you want Event Replicator Target Adapter to interact.

~ To set up a JMS target definition for the Event Replicator Target Adapter, complete the following steps:

You must have a JMS target or queue created that is designed to handle the replicated data. For
information on setting this up, consult the JMS provider documentation.

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

3 Right-click on the JMS categorization and select New from the drop-down menu.
Or:
Select the New command from the File menu and then JMS Target from the resulting submenu.

An untitled JMS target definition panel appears on the right side of the Administration tool
window, as shown below:
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@ Event Replicator Target Adapter Administration

File Run Window Help
EGE
~ @ Target Adapter
v @ Local Target Adapter
~ % Configuration File
~ &1 Configurations
3 Engine
" Repository
3 Filter
f Sources
03 Target Database Options
~ @ Targets
2 Adabas
£ Adabas (Binary)
« @ Apama
@ Apama
»" BigMemory Max
50 BigMemory Max Merge
0 Database
12 IMS
Terracotta
A Web Service
@, Target Adapter

32 Untitled 10 [Local Target Adapter] & |

Description: |

Properties

Provider URL: | wmjmsnaming://<broker name>@ <server name >:6849

Factory Initial: [ com.webmethods.jms.naming.WmJmsMNamingCtxFactory

Lookup Names

Destination:

Connection Factory:

Options

[] Keep Empty Value

[[] Update to Insert

Include Commit Information:

no

with ET method
yes

4 Supply valid values for the JMS queue or topic. The JMS fields are described here.
Field Name Value
Description Type a description for this target definition.
Provider URL |Supply the fully-qualified URL of the initial context of the JNDI provider in which

the JMS-administered objects should be stored by the Event Replicator Target Adapter.
This JNDI provider must be managed by the JMS provider.

Factory Initial

The class name of the JNDI factory. This JNDI factory must be managed by the JMS
provider.

Destination Supply the lookup name of the destination. This is either the name of the JMS topic
or the JMS queue, as defined by the JMS provider.

Connection Supply the name of the topic (publish-subscribe) or queue (point-to-point) connection

Factory factory to be used, as defined by the JMS provider.

Keep Empty  |Select this option (check it) to indicate that all values of periodic (PE) fields or

Value multiple-value (MU) fields within PE fields should be replicated, even if they are
empty. If this option is NOT selected, only non-empty values of PE fields or MU
fields within PE fields are replicated.
This option is only available for JMS targets when running the Event Replicator with
OPTIONS=32 on the mainframe.

Update to Insert |Select this option (check it) to indicate that update commands should be converted

to insert commands. When this option is selected, the Event Replicator Target Adapter
first issues a delete of the existing row if it exists and then inserts a new row with the
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Field Name

Value

changed information instead of issuing an update command. To use this feature, the
mainframe replication OPTIONS parameter specified in the destination class
parameter data (DCLASSPARM parameter) must be set to 32 (OPTIONS=32). For
more information read DCLASSPARM Parameter, in the Event Replicator for Adabas
Reference Guide.

Caution: Specifying the OPTIONS=32 option results in the entire Adabas record

image being sent to the Event Replicator Target Adapter and can lead to the
degradation of overall throughput and performance of the Event Replicator Target
Adapter.

The default is to leave this option unchecked (unselected).

Note: This setting is ignored for requests to use a loader to process and load

initial-state data. For more information about the option to use a loader, read about
the Use Loader option.

Include Commit
Information

Select an option from the drop-down menu on whether and how to include Adabas
commit time information in the replicated data for all processed transactions.

= Option "with ET method" is the equivalent of a false (unchecked box) value in
previous Event Replicator Target Adapter versions and will produce output for
the transaction information as follows:

<?xml version="1.0" encoding="UTF-8"7>
<artdocument version="1" committed="2018/10/04-12:46:41.284060">
<method>update</method>
<tableName>EMPLOYEES</tableName>
<fields>
<field name="ISN" value="1130" />
<field name="CITY" value="Auckland2" />
</fields>
</artdocument>
<?xml version="1.0" encoding="UTF-8"7>
<artdocument version="1" committed="2018/10/04-12:46:41.284060">
<method>ET</method>
<{/artdocument>

® Option "yes" will provide the commit information in the following format:

<?xml version="1.0" encoding="UTF-8"7>
<artdocument version="1" committed="2018/10/04-12:44:42.834695">
<method>update</method>
<tableName>EMPLOYEES</tableName>
<fields>
<field name="ISN" value="1130" />
<field name="CITY" value="Auckland" />
</fields>
</artdocument>
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Field Name Value

® The default is "no", no commit information is provided.

Once all fields have been specified satisfactorily, click the Save button (L5) on the toolbar to
save the target JMS definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
Maintaining BigMemory Max and BigMemory Max Merge Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to a BigMemory Max cache. To do this, you must create a target definition for a Big-
Memory Max environment with which you want Event Replicator Target Adapter to interact. The
Event Replicator Target Adapter offers two different BigMemory Max targets: “BigMemory Max”
and “BigMemory Max Merge”. “BigMemory Max” replicates an Adabas file to a BigMemory Max
cache. “BigMemory Max Merge” has the ability, but is also able to merge multiple Adabas files to
one cache via a single key.

~ To set up a BigMemory Max target definition for the Event Replicator Target Adapter, complete the following
steps:

You must have a BigMemory Max environment that is designed to handle the replicated data. For
information on setting this up in BigMemory Max, read Terracotta documentation on Software
AG's Empower web site.
1  Start up the Administration tool, as described in Starting the Administration Tool.
2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.
The high-level categorizations of the target definitions appear.

3 Right-click on the BigMemory Max categorization and select New from the drop-down menu.

Or:
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Select the New command from the File menu and then BigMemory Max Target from the
resulting submenu.

An untitled BigMemory Max target definition panel appears on the right side of the Admin-
istration tool window, as shown below:

BigMemory Max target:

@, Event Replicator Target Adapter Administration - O X

File Run Window Help
L
~ @ Target Adapter «" Untitled 13 [Local Target Adapter] & =0
~ @ Local Target Adapter
~ 5 Configuration File
~ & Configurations
=3 Engine Config File: | Browse...
=" Repository
3 Filter
> [ Sources
> 03 Target Database Options
~ @ Targets
£ Adabas
2 Adabas (Binary)
> @ Apama
=" BigMemory Max
50 BigMemory Max Merge
@ Database
12 IMs
; Terracotta
A Web Service
> @, Target Adapter

Description: |

Parameter

Target Adapter ‘Local Target Adapter’ is inactive.

BigMemory Max Merge target:
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@, Event Replicator Target Adapter Administration - O *

File Run Window Help

LK

~ @ Target Adapter 59 Untitled 12 [Local Target Adapter] 2
v @ Local Target Adapter

~ % Configuration File

~ ¥ Configurations

Description: |

Parameter

=3 Engine Config File: | Browse...

= Repository
3 Filter

Properties

H Sources Cache Name Key Files Add

03 Target Database Options
~ @ Targets
£ Adabas
£ Adabas (Binary)
@ Apama
=" BigMemory Max
50 BigMemory Max Merge
0 Database
12, IMS
Terracotta
i Web Service
@, Target Adapter

Remaove

Target Adapter ‘Local Target Adapter' is inactive. H

Supply valid values for the BigMemory Max target. The BigMemory Max fields are described

in the following table:

Field Name  |Value

Description |Type a description for this target definition.

Config File |Supply the path to ehcache.xml. BigMemory Max offers different types of cache: from
local cache to clustered server arrays. All parameters are controlled by the ehcache.xml
file. In order to connect to the right BigMemory Max instance, the Event Replicator
Target Adapter will use the specified configuration file. More details about the
configuration file can be found in the BigMemory Max documentation.

Properties  |Note: Only applicable for BigMemory Max Merge targets. By clicking on the “Add”
button a new merge cache definition can be defined.

Cache Name [Name of the merged cache.

Key Key that must exist in every merged file.

Files List of Adabas Files that are merge in the cache. The file must be separated with a comma.

[
Once all fields have been specified satisfactorily, click the Save button ( Eﬁ]) on the toolbar to

save the target Terracotta definition.

Or:

Select the Save command on the File menu of the Administration tool.
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A “Save As” pop-up window appears.

Specify the name of the new target definition on the “Save As” pop-up window and then
click the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.

| Note: The ehcache.xml file is not affected by any entries made here. You must provide

ehcache.xml according to your cache configuration. See the BigMemory Max document-
ation on Software AG's Empower web site for more information on ehcache.xml.

Maintaining Web Service Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to a web service instead of an SQL database. To do this, you must create a target
definition for each unique web service with which you want Event Replicator Target Adapter to
interact.

~ To set up a web service target definition for the Event Replicator Target Adapter, complete the following
steps:

You must have a web service created that is designed to handle the replicated data.

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

Right-click on the Web Service categorization and select New from the drop-down menu.
Or:

Select the New command from the File menu and then Web Service Target from the resulting
submenu.

An untitled web service target definition panel appears on the right side of the Administration
tool window, as shown below:
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@, Event Replicator Target Adapter Administration - O X
File Bun Window Help

b E
~ @ Target Adapter 44 Untitled 23 [Local Target Adapter] &2 =0

« @ Local Target Adapter

. ) Description: | |
~ % Configuration File

&1 Configurations Web Service URL: | |

3 Filter
3 Sources
o Target Database Options
w Targets
2 Adabas
£ Adabas (Binary)
@ Apama
=" BigMemory Max
59 BigMemory Max Merge
0 Database
=
@ Terracotta
ia Web Service
@, Target Adapter

Target Adapter 'Local Target Adapter is inactive. &

4 Supply valid values for the web service. The web service fields are described here.

Field Name Value

Description Type a description for this target definition.

Web Service URL |Use this parameter to supply the fully-qualified URL of your web service.

.
Once all fields have been specified satisfactorily, click the Save button ([B]) on the toolbar to
save the target web service definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
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Maintaining Adabas Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to Adabas on Linux, UNIX and Windows. To do this, you must create a target definition
for the Adabas environment you want Event Replicator Target Adapter to interact with.

Note: Use of short names in Adabas to Adabas replication requires Event Replicator for
Adabas Version 3.7.1 with zap AZ371002 applied.

When the Target Adapter receives data that is bound for an Adabas target, it will leverage func-

tionality provided by Adabas Client for Java (ACJ) to store data in the target. Adabas short names
are used in the replication unless an ACJ map is defined. For more information on replication to

an Adabas target and the use of maps, please refer to the Event Replicator Target Adapter document-
ation.

~ To set up an Adabas target definition for the Event Replicator Target Adapter, complete the following steps:

You must have an Adabas environment that is designed to handle the replicated data. For inform-
ation on setting up Adabas, refer to the Adabas documentation on Software AG's Empower web
site.

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

3 Right-click on the Adabas categorization and select New from the drop-down menu.
Or:

Select the New command from the File menu and then Adabas Target from the resulting
submenu.

An untitled Adabas target definition panel appears on the right side of the Administration
tool window, as shown below:
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@ Event Replicator Target Adapter Administration - O X
File Run Window Help
>
~ @ Target Adapter £ Adabas [Local Target Adapter] 2 =0
v @ Local Ta_rget gdapt_er Descn’ption;| |
+ & Configuration File
~ 1 Configurations Parameter
=3 Engine Connection String: | |
" Repository Map File Number: | |
+ Filter [[] Keep Map when File is dropped
0 Sources

o3 Target Database Options
v @ Targets
~ 2 Adabas
£ Adabas
£ Adabas (Binary)
@ Apama
s" BigMemory Max
50 BigMemory Max Merge
0 Database
12, IMs
Terracotta
i Web Service
@), Target Adapter

Target Adapter ‘Local Target Adapter’ is inactive. H

4  Supply valid values for the Adabas target. The target fields are described below:

Field Name Value
Description Type a description for this target definition.
Connection String Connect string to access Adabas. For details check the Adabas Client for

Java (ACJ]) documentation.
Examples:
24 —local database 24

123(tcpip://10.20.30.40:123) - remote database accessed through
Entire Net-Work on host 10.20.30.40 and port number 123

Map File Number Map file number on the Target database.

Note: Only needed when ACJ maps are used.

Keep Map when File is The Event Replicator Target Adapter deletes the file if the drop command
dropped is received. When a map is used this option controls whether the map is
kept.

Note: Only needed when ACJ maps are used.
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Once all fields have been specified satisfactorily, click the Save button (L)) on the toolbar to
save the Adabas target definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
Maintaining Adabas (Binary) Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to Adabas on Linux, UNIX and Windows using raw binary source data. This method
is analogous to Node to Node replication on the mainframe and bypasses conversion of replicated
transactions to XML data as is used in other replication scenarios. To do this, you must create a
target definition for the Adabas environment you want Event Replicator Target Adapter to interact
with.

~ To set up an Adabas (Binary) target definition for the Event Replicator Target Adapter, complete the following
steps:

You must have an Adabas environment that is designed to handle the replicated data. The target
database must be accessible via a lookup in a Software AG Directory Server. The Directory Server
Entry is normally created by an Entire Net-Work node that services that Adabas target and registers
the database with the Directory Server. For information on setting up Adabas and configuring its
access via Entire Net-Work, refer to the documentation for those products on Software AG's Em-
power web site.

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

3  Right-click on the Adabas (Binary) icon and select New from the drop-down menu.

Or:
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Select the New command from the File menu and then Adabas (Binary) Target from the
resulting submenu.

An untitled Adabas (Binary) target definition panel appears on the right side of the Adminis-
tration tool window, as shown below:

@, Event Replicator Target Adapter Administration - ] X

Eile Run Window Help
4 [
v @ Target Adapter = Adabas [Local Target Adapter] | = Untitled 2 [Local Target Adapter]
v @ Local Target Adapter Description:
~ [ Configuration File EaOreTies

% Configurations
¥ Filter
9 Sources Database Table

9§ Target Database Options

Adabas Directory Server:  tcpip://<host>:<port>

Source Database ID Source File Number Target Database ID Target File Number Add
v @ Targets

2 Adabas Remove
~ & Adabas (Binary)
2 Adabas
@ Apama
=" BigMemory Max
& BigMemory Max Merge
0 Database
12 JMS
@ Terracotta
A Web Service
» & Target Adapter
la Adabas Analytics Collector MF

|Terget Adapter 'Local Target Adapter’ is inactive.

4  Supply valid values for the Adabas target. The target fields are described below:

Field Name Value

Description Enter a description for this target definition.

Adabas Directory Server |Connection string to the Software AG Directory Server:
tepip://<host>:<port>

Database Table Use this table to map the source files to the target files. Use the Add button
to add new rows and the Remove button to remove a row.

5  The Software AG Directory Server is used for doing lookup of the Adabas target.

6  For the mapping of the target files to the source files, wildcard notations are available as well
as excluding files from the replication. Here are some examples:

Event Replicator Target Adapter Administration 71



Using Event Replicator Target Adapter Administration

Database Table

Source Database 1D Source File Number Target Database ID Target File Number Add

! 2 3 4 o Remove
5 * (2

6 : 106 * (3 )

|
o the file from source database 1 with file number 2 is mapped to target database 3 with
file number 4

|
9 all files from source database 5 are not processed (ignored)

e all files from source database 6 are mapped to target database 106

Once all fields have been specified satisfactorily, click the Save button (L&) on the toolbar to
save the Adabas (Binary) target definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specity the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
Maintaining Terracotta Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to a Terracotta target. To do this, you must create a target definition for the Terracotta
environment you want Event Replicator Target Adapter to interact with.

Terracotta behaves like a relational database system with datasets that are comparable to tables
in an RDBMS.

~ To set up a Terracotta target definition for the Event Replicator Target Adapter, complete the following steps:

You must have a Terracotta environment that is designed to handle the replicated data. For inform-
ation on setting up Terracotta, refer to the Terracotta documentation on Software AG's Empower
web site.
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1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

3 Right-click on the Terracotta categorization and select New from the drop-down menu.

Or:

Select the New command from the File menu and then Terracotta Target from the resulting
submenu.

An untitled Terracotta target definition panel appears on the right side of the Administration
tool window, as shown below:

@, Event Replicator Target Adapter Administration - O *
Eile Bun Window Help
D‘ =
~ @ Target Adapter Terracotta [Local Target Adapter] = =0
s r il
= _l_.::l:al Taltget Adapter Description: | |
~ L Configuration File
= i . Parameter
wd Configurations
2% Filter Terracotta Server. |
B Sources Dataset Creation
a -
05 Target Database Options Off-heap Resource Name: |
w @ Targets |
2 pAdabas Data Root Name:
2 Adabas (Binary)
@ spama

=" BigMemaory Max
50 BigMemary Max Merge
0 Database
42 IMS

~ @ Terracotta

Terracotta
4 Web Service
@, Target Adapter

Target Adapter ‘Local Target Adapter’ is inactive. H

4  Supply valid values for the Terracotta target. The Terracotta fields are described here.
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Field Name Value
Description Type a description for this target definition.
Terracotta Server Connection string to Terracotta Server: terracotta://<host>:<port>

Off-heap Resource Name |Off-heap resource name as defined in the configuration file tc-config.xml.

Data Root Name Data root name as defined in the configuration file tc-config.xml.

Note: Only needed if persistence is required.

Once all fields have been specified satisfactorily, click the Save button (L) on the toolbar to
save the Terracotta target definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
Maintaining Apama Target Definitions

You can configure the Event Replicator Target Adapter to stream replicated data from the Event
Replicator to an Apama target. To do this, you must create a target definition for the Apama en-
vironment you want Event Replicator Target Adapter to interact with.

With the Apama Target, Adabas business data can be sent to Apama for further processing. The
schema how the data is sent to Apama can be learned from the code below:

package com.softwareag.adabas;

/** This event type contains the Adabas Business Data */
event AdabasBusinessData {
dictionary<string, string> fields;
dictionary<string, sequence<string> > multiple_fields;
dictionary<string, sequence<AdabasBusinessData> > periodic_groups;
}

/** This event type contains the Adabas Business Event */
event AdabasBusinessEvent f{

string method;

string table_name;

string key;

AdabasBusinessData data;
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The following are examples for Adabas business data that is sent to Apama.

Insert

com.softwareag.adabas.AdabasBusinessEvent(
"Insert",
"EMPL_EMPLOYEES",
"1111",
com.softwareag.adabas.AdabasBusinessDatal(
{
"CITY":"AuckTand",
"COUNTRY":"NZ",
"DEPT":"SALEOL",
"FIRST_NAME":"Max",
"ISN":"1111",
"NAME" : "Johnson",
"PERSONNEL_ID":"12345678"
b,
{
"LANG":["ENG","FRA"]
',
{
"INCOME" :
[
com.softwareag.adabas.AdabasBusinessDatal(
{
"CURRCODE":"FRA",
"SALARY":"159980"
b,
{
"BONUS":["23000"]

Update

com.softwareag.adabas.AdabasBusinessEvent(
"Update",
"EMPL_EMPLOYEES",
"1111",
com.softwareag.adabas.AdabasBusinessData(
{"CITY":"WelTlington","ISN":"1111"},
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Delete

com.softwareag.adabas.AdabasBusinessEvent(
"Delete",
"EMPL_EMPLOYEES",
"1111",
com.softwareag.adabas.AdabasBusinessDatal(
{"ISN":"1111"},
{1,
{1
)
)

~ To set up an Apama target definition for the Event Replicator Target Adapter, complete the following steps:

You must have an Apama environment that is designed to handle the replicated data. For inform-
ation on setting up Apama, refer to the Apama documentation on Software AG's Empower web
site.

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions appear.

3  Right-click on the Apama categorization and select New from the drop-down menu.
Or:

Select the New command from the File menu and then Apama Target from the resulting
submenu.

An untitled Apama target definition panel appears on the right side of the Administration
tool window, as shown below:
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@, Event Replicator Target Adapter Administration - O <
Eile Run Window Help

> =
~ @ Target Adapter @ Apama [Local Target Adapter] & =0

v @ Local Target Adapter

= Description: | |
~ g Configuration File
= - - Parameter
%4 Configurations
T Filter Host: |

o3 Target Database Options
~ @ Targets
2 Adabas
2 Adabas (Binary)
~ @ Apama
@ Apama
=" BigMemory Max
59 BigMemory Max Merge
0 Database
42, IMs
Terracotta
£ Web Service
v @, Target Adapter
= Logs

|
i Sources Port: | |
Process Name: |

Target Adapter ‘Local Target Adapter’ is inactive. H

4 Supply valid values for the Apama target. The target fields are described here.

Field Name Value

Description  |Type a description for this target definition.

Host Use this parameter to identify the Apama host name.

Port Use this parameter to identify the Apama port.

Process Name |Use this parameter to identify the Apama Process name.

Note: This parameter is optional.

(B
Once all fields have been specified satisfactorily, click the Save button (I:G]) on the toolbar to
save the Apama target definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new target definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
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Modifying Existing Target Definitions

~ To modify an existing target definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions (Database and Web Service) appear.

Expand the Database, JMS, or Web Service categorizations, locate the target definition you
want to modify in them, and double-click on the name.

The definition opens on the right side of the Administration tool.

Modify the values of the target definition as described in Defining New RDBMS Database
Target Definitions and Defining New Web Service Target Definitions, elsewhere in this section.

Once all fields have been specified satisfactorily, click the Save button (L&) on the toolbar to
save the target definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Renaming Existing Target Definitions

~ To rename an existing target definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.

The high-level categorizations of the target definitions (Database and Web Service) appear.
Expand the Database, JMS, or Web Service categorizations, locate the target definition you

want to rename, and right-click on the name.

A drop-down menu appears providing you with several options.
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Select the Rename option on the drop-down menu.

A Rename dialog for the target definition appears. Here is a sample of such a dialog when
you rename a database target:

@ Rename X

Please enter 2 new name:

My new namel

Supply a new name for the target definition in the input field and click OK.

Make sure you have altered any source definitions that reference the target definition. For
more information, read Configuring Source Definitions for Event Replicator Target Adapter,
elsewhere in this guide.

In addition, make sure that any target database option definitions with the same name are
also renamed. Target database option definitions must have the same name as any target
database to which they apply (unless the default definition is used). For more information,
read Specifying Target Database Processing Option Definitions, elsewhere in this guide.

Once all fields have been specified satisfactorily, click the Save button (I-Ill) on the toolbar to
save the target definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Deleting Existing Target Definitions

~ To delete an existing target definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then the Targets section.
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The high-level categorizations of the target definitions (Database and Web Service) appear.
3  Expand the Database, JMS, or Web Service categorizations, locate the target definition you

want to delete, and right-click on the name.

A drop-down menu appears providing you with several options.

4  Select the Delete option on the drop-down menu.

A dialog prompting you to verify that you really want to delete the target definition appears.
5  Select Yes to delete the definition.

6  Make sure you have altered any source definitions that reference the target definition. For
more information, read Configuring Source Definitions for Event Replicator Target Adapter,
elsewhere in this guide.

Configuring Target Definitions for Adabas Analytics Collector MF

The Adabas Analytics Collector MF currently supports one type of target to which analytics data
can be submitted: Elasticsearch. Before you can use the Adabas Analytics Collector MF, you must
set up a target definition for every unique target you intend to use for the analytics data the Adabas
Analytics Collector MF processes. These definitions provide Adabas Analytics Collector MF with
the information it needs to access your target.

= Maintaining Elasticsearch Database Target Definitions
= Maintaining Apama Target Definitions

= Modifying Existing Target Definitions

= Renaming Existing Target Definitions

= Deleting Existing Target Definitions

| Note: You will need to restart the Adabas Analytics Collector MF servive or daemon to fully

process any additions or changes made to Adabas Analytics Collector MF configuration
definitions in the Administration tool.

Maintaining Elasticsearch Database Target Definitions

You must define target definitions for each unique Elasticsearch target you intend to use with the
Adabas Analytics Collector MF prior to using the collector. These definitions will provide Adabas
Analytics Collector MF with the information it needs to access your Elasticsearch.

| Note: Do not copy the context.xml, server.xml, or any configuration file from an older install-

ation and expect it to work for this installation. Errors will result if you try this.
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~ To define a target definition for Elasticsearch:

1 Make sure you have completed all of the installation instructions specific to your Elasticsearch,
as described in the Adabas Analytics Collector MF documentation.

2 Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

3 On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF section, your Adabas Analytics Collector MF environment and then the Targets section.
The high-level categorizations of the target definitions appear.

4  Right-click on the Elasticsearch node and select New from the drop-down menu.
Or:

Select the New command from the File menu and then Elasticsearch Target from the resulting
submenu.

An untitled Elasticsearch definition panel appears on the right side of the Administration tool
window, as shown below:

@, Event Replicator Target Adapter Administration

File Run Window Help

@ Target Adapter % ES1 [localEAP]
v l& Adabas Analytics Coll Host: [ localhast
~ g localEAP
. Port: | 9200
3 Sources
~ @ Targets Index: | targetadapter
@ Apama Authorization

v % Elasticsearch User
% ES
% ES1

user

Password: | ********

5  Supply valid values for the Elasticsearch installed at your site. The database fields are described
here.

Field Name |Value

Host Use this parameter to identify the Elasticsearch host name.

Port Use this parameter to identify the Elasticsearch port. The default of 9200 is given.
Index Use this parameter to identify the Elasticsearch index name.

User Use this parameter to identify the Elasticsearch user, if required.

Password |Use this parameter to identify the Elasticsearch password, if required.
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Maintaining Apama Target Definitions

You must define target definitions for each unique Apama target you intend to use with the
Adabas Analytics Collector MF prior to using the collector. These definitions will provide Adabas
Analytics Collector MF with the information it needs to access your Apama.

With the Apama Target Adabas Analytic data can be sent to Apama for further processing. The
schema how the data is sent to Apama can be seen from the code below:

package com.softwareag.adabas;

/** This event contains the Adabas Analytic Data */
event AdabasAnalyticsEvent (|
string name;
string date;
dictionary<string, string> fields;
}

Here is an example for Adabas Analytic data that is sent to Apama:

com.softwareag.adabas.AdabasAnalyticsEvent(
"ReptorStatisticGlobal",
"Thu Sep 12 14:03:03 CEST 2019",
{
"dbFCBFDTTransOnSLOG":"0",
"dbTransDeloggedSLOG":"0",
"dbTransLoggedSLOG":"0",
"dbTransOnSLOG":"0",
"inputTransactions":"0",
"intervallength":"60002",
"nucleusID":"0",
"pendingInputTransactions":"0",
"reptorStatus":"RSTA",
"targetID":"22133",
"timestamp":"Thu Sep 12 14:02:03 CEST 2019",
"timestampEnd":"Thu Sep 12 14:03:03 CEST 2019",
"totalBackoutsAllQueues":"0",
"totalBytesAllDests":"22784",
"totalBytesAllQueues":"0",
"totalCommitsAlTQueues":"0",
"totalltemsDeloggedSLOG":"0",
"totalItemsLoggedSLOG":"0",
"totalltemsOnSLOG":"0",
"totalMessagesAllDests":"24",
"totalMessagesAllQueues":"0",
"type":"ReptorStatisticGlobal"
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~ To define a target definition for Apama:

1

5

Make sure you have completed all of the installation instructions specific to your Apama, as
described in the Adabas Analytics Collector MF documentation.

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MEF section, your Adabas Analytics Collector MF environment and then the Targets section.
The high-level categorizations of the target definitions appear.

Right-click on the Apama node and select New from the drop-down menu.
Or:

Select the New command from the File menu and then Apama Target from the resulting
submenu.

An untitled Apama definition panel appears on the right side of the Administration tool
window, as shown below:

F ~

@ Event Replicator Target Adapter Administration =R X

Eile Bun Window Help

=EJ Target Adapter ﬁ Untitled 1 [EAP] &2 = O
4 iy Adabas Analytics Collector MF
‘& EAP Host:
> a Sources Port: 0
4 (@ Targets
‘ Apama Mame:
apama

: ## Elasticzearch

Supply valid values for the Apama installed at your site. The database fields are described
here.
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Field Name | Value

Host Use this parameter to identify the Apama host name.
Port Use this parameter to identify the Apama port.
Name Use this parameter to identify the Apama Process name.

Note: This parameter is optional.

Modifying Existing Target Definitions

~ To modify an existing target definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF section, your Adabas Analytics Collector MF environment and then the Targets section.

The high-level categorization of the target definitions (Elasticsearch) appears.

Expand the Elasticsearch categorizations, locate the target definition you want to modify,
and double-click on the name.

The definition opens on the right side of the Administration tool.

Modify the values of the target definition as described in Maintaining Elasticsearch Database
Target Definitions, elsewhere in this section.

Once all fields have been specified satisfactorily, click the Save button (|-I1|) on the toolbar to
save the target definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Adabas Analytics Collector MF.
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Renaming Existing Target Definitions

~ To rename an existing target definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF section, your Adabas Analytics Collector MF environment and then the Targets section.
The high-level categorization of the target definitions (Elasticsearch) appears.

Expand the Elasticsearch categorization, locate the target definition you want to rename, and
right-click on the name.

A drop-down menu appears providing you with several options.

Select the Rename option on the drop-down menu.

A Rename dialog for the target definition appears.
Supply a new name for the target definition in the input field and click OK.

Make sure you have altered any source definitions that reference the target definition. For
more information, read Configuring Source Definitions for Adabas Analytics Collector MF,
elsewhere in this guide.

Deleting Existing Target Definitions

~ To delete an existing target definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF section, your Adabas Analytics Collector MF environment and then the Targets section.
The definition opens on the right-hand side of the Administration tool.

Expand the Elasticsearch categorization, locate the target definition you want to delete, and
right-click on the name.

A drop-down menu appears providing you with several options.

Select the Delete option on the drop-down menu.

A dialog prompting you to verify that you really want to delete the target definition appears.
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5  Select Yes to delete the definition.

6  Make sure you have altered any source definitions that reference the target definition. For
more information, read Configuring Source Definitions for Adabas Analytics Collector MF,
elsewhere in this guide.

Specifying Target Database Processing Option Definitions

You can set processing options for your target databases. You do this by creating and using target
database processing option definitions.

= Creating a New Target Database Option Definition

= Modifying Existing Target Database Option Definitions
= Renaming Existing Target Database Option Definitions
= Deleting Existing Target Database Option Definitions

| Note: You will need to restart the Event Replicator Target Adapter to fully process any ad-

ditions or changes made to Event Replicator Target Adapter Configuration definitions in
the Administration tool. For more information, read Restarting the Event Replicator Target
Adapter, in the Event Replicator Target Adapter User Guide.

Creating a New Target Database Option Definition

You must define target definitions for each unique RDBMS database you intend to use with the
Event Replicator Target Adapter prior to using Event Replicator Target Adapter. These definitions
provide Event Replicator Target Adapter with the information it needs to access your RDBMS
and to communicate with Event Replicator for Adabas via webMethods EntireX or WebSphere

MQ.

| Note: Do not copy the context.xml, server.xml, or any configuration file from an older install-

ation and expect it to work for this installation. Errors will result if you try this.

~ To create a new target database option definition:
1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.
2 On the left side of the Administration tool window, expand the Configuration File section.
3  Right-click on the Target Database Options section and select New from the drop-down

menu.

Or:
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Select the New command from the File menu and then Target Database Option from the

resulting submenu.

An untitled target database option definition panel appears on the right side of the Adminis-

tration tool window, as shown

@ Event Replicator Target Adapter Administration

Eile Bun Window Help
[ ,:Z.
~ @ Target Adapter
~ @ |ocal Target Adapter

« [ Configuration File
~ % Configurations
=4 Engine
. Repository

3 Filter

. Sources

o3 Target Database Options
of default
> @ Targets

» @, Target Adapter

Target Adapter ‘Local Target Adapter’ is inactive.

4
following table:

|08 default [Local Target Adapter] i3 |

below:

Description: |TargetD80pt|'ons-defauit

|0

Batch Count:

Adabas-RDBMS Synchronization Level: apply

b

Options

[] Convert Hyphen

[ Lowercase

Use Quote

[ Error Continue

[] Delete befare Insert

[ update to Insert

[_] Binary Fields as RAW Data Type (Oracle only)

Teradata Options
] Reuse Connection

Microsoft SQL Server Options

[] Use User-defined Empty Value
Null for Type Decimal
Mull for Type Float

Loader
Loader configuration for either Oracle, Teradata, Microsoft SQL Server, DB2 or PostgreSQL.
[ use Loader

Oracle Service, Teradata Tdpip, DB2 Alias or
Micrasoft SOL/PostgreSQOL Schema Name:

Path to Loader Executable: | Browse...
Options (MSSQL, Cracle or DB2 only): |
Environment File: | Browse...

[] Use Stream (Qracle only)

Number of Parallel Loaders:

4

Verify and update the values for the database option definition panel, as described in the
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Field Name Description
Description Specify a description for the database option definition.
Batch Count Specify zero (0) for this field unless specifically directed to change it by a support

representative.

This field specifies the recommended maximum number of SQL statements that
should be grouped and sent to the RDBMS to process as a batch. Use of this
environment entry can be used to improve the performance of your database and
is especially useful if you are requesting that initial-state data or ADALOD data be
replicated to your RDBMS database. The value you specify should be selected based
on your RDBMS database and network configuration requirements.

If you specify zero ("0") for this field, all SQL statements generated for a transaction
are grouped and processed in a single batch. If you specify any other value for this
field, then any generated SQL statements are grouped and processed in batches of
statements that do not exceed the number of statements you specified. For example
if you set this field to 1000, a maximum of 1000 SQL statements would be grouped
and processed in a single batch.

Note:

1. A single Adabas transaction can result in multiple SQL statements to update the
RDBMS database. To maintain database integrity, the Event Replicator Target
Adapter will be sure to group and process all of the SQL statements generated
for an individual transaction in one batch, regardless of the setting of the Batch
Count field.

2. The Event Replicator Target Adapter does not support use of this field for
Teradata databases; consequently, you should be sure that this field is set to zero
(0) for Teradata databases.

Adabas-RDBMS
Synchronization
Level

Select the level at which the Event Replicator Target Adapter should synchronize
the RDBMS table layout with the Adabas file.

The RDBMS-Adabeas file synchronization (activated by this option) is triggered by
the use of a new GFB and field table (GFFT) in the subscription you use for
replication. Therefore, if you make changes to your Adabas database file or field
structure, you must generate a new GFB/GFFT (using the Data Mapping Tool) and
apply it to the appropriate subscription definition, prior to replicating data with
the new structure.

Valid values for this option are:

= jgnore: This is the default. The existing table layout is ignored, differences between
the RDBMS table layout and the Adabas file are ignored, and no synchronization
occurs.

This setting might cause Event Replicator Target Adapter processing to stop if
you have made changes to your Adabas database file or field structure and have
included a newly-generated GFB/GFFT in the subscription you use for replication.
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Field Name

Description

When the Event Replicator Target Adapter receives the newly-structured
replicated data, but this option is set to "ignore", it will not attempt to synchronize
the RDBMS table layout with the new Adabas database structure. Any new or
enhanced fields will not be recognized by the Event Replicator Target Adapter
and processing will stop.

= warn: Warning messages are written to the log about the differences between the
RDBMS table layout and the Adabas file, but no synchronization occurs.

This setting might cause Event Replicator Target Adapter processing to stop if
you have made changes to your Adabas database file or field structure and have
included a newly-generated GFB/GFFT in the subscription you use for replication.
When the Event Replicator Target Adapter receives the newly-structured
replicated data, but this option is set to "ignore", it will not attempt to synchronize
the RDBMS table layout with the new Adabas database structure (although it
will issue a warning message). Any new or enhanced fields will not be recognized
by the Event Replicator Target Adapter and processing will stop.

= error: Event Replicator Target Adapter processing stops if the differences between
the RDBMS table layout and Adabas file cause errors. No synchronization occurs.

= apply: The RDBMS is altered (synchronized) with the Adabas file, with the
following limitations:

® No columns in the RDBMS table are removed, although they can be added.
® The size or length of a data field will not be reduced. It can only be increased.

® Data type conversions will not occur (for example, if Column A used to be an
integer but has been changed to VARCHAR).

® Added or altered columns cannot contain foreign key, unique key, or a primary
key attribute.

= RDBMS columns cannot be renamed.

Convert Hyphen

Select this option (check it) to indicate that hyphens (-) in table and column names
should be automatically converted to underscore characters (_).

When you select this option, it indicates that hyphens in table and column names
should be converted to underscore characters; if you do not select this option, it
indicates that they should not.

Lowercase

Select this option (check it) to indicate that the table and column names should be
automatically converted to lowercase.

When you select this option, it indicates that table and column names should be
converted to lowercase; if you do not select this option, it indicates that they should
not.

Use Quote

Select this option (check it ) to indicate that table and column names should be
included in quotation marks (").

When you select this option, it indicates that the table and column names should
be included in quotation marks; if you do not select this option, it indicates that
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Field Name

Description

they should not. Be aware that not selecting this option has performance implications
because this setting causes the Event Replicator Target Adapter to analyze each
table and column name for use of special characters.

Error Continue

Select this option (check it) to indicate that Event Replicator Target Adapter should
continue processing when SQL transaction errors occur.

When you select this option, it indicates that, after logging the error, Event Replicator
Target Adapter should continue processing data when a SQL transaction error
occurs; if you do not select this option, it indicates that, after logging the error, Event
Replicator Target Adapter should terminate.

Delete before
Insert

Select this option (check it) to indicate that an existing record should be deleted
before its replacement is inserted in the table. This allows you to specify how resent
data from the Event Replicator is handled in the table. Data will be resent from the
Event Replicator if Event Replicator abnormally terminates and then is restarted.

Note: This setting is ignored for requests to use a loader to process and load

initial-state data. For more information about the option to use a loader, read about
the Use Loader option.

When you select this option, it indicates that existing records should be deleted
before their replacements are inserted; if you do not select this option, it indicates
that the replacement records should simply be inserted without deletion. Be aware
that selecting this option has performance implications because Event Replicator
Target Adapter must first determine whether each record it processes already exists
in the table.

Update to Insert

Select this option (check it) to indicate that update commands should be converted
to insert commands. When this option is selected, the Event Replicator Target
Adapter first issues a delete of the existing row if it exists and then inserts a new
row with the changed information instead of issuing an update command. To use
this feature, the mainframe replication OPTIONS parameter specified in the
destination class parameter data (DCLASSPARM parameter) must be set to 32
(OPTIONS=32). For more information read DCLASSPARM Parameter, in the Event
Replicator for Adabas Reference Guide.

Caution: Specifying the OPTIONS=32 option results in the entire Adabas record

image being sent to the Event Replicator Target Adapter and can lead to the
degradation of overall throughput and performance of the Event Replicator Target
Adapter.

The default is to leave this option unchecked (unselected).

Note: This setting is ignored for requests to use a loader to process and load

initial-state data. For more information about the option to use a loader, read about
the Use Loader option.

Binary Fields as
RAW Data Type

Binary Fields will be stores in Oracle fields with data type ‘raw’.
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Field Name Description

(Oracle only)

Reuse This option is only useful for Teradata databases.
Connection

Select this option (check it) to indicate that the data source connection should be
reused, instead of using the Tomcat connection pool. By selecting this option, you
can reduce the number of SQL commands issued by the JDBC driver, thus reducing
the performance overhead of Event Replicator Target Adapter processing to Teradata
databases.

The default is to leave this field unselected (unchecked).

User-Defined
Empty Value

This option is only useful for Microsoft SQL Server databases.

Select this option (check it) to indicate that zero or null should be used to represent
an empty value for numeric, integer, or floating point fields directed to Microsoft
SQL Server databases. When you select this option, the Null for Type Decimal and
Null for Type Float fields become selectable.

The default is to leave this field unselected (unchecked).

This option was introduced in an Event Replicator Target Adapter hot fix, prior to
release 2.6. If you want to set this as the default for tables created before this option
was made available in the Event Replicator Target Adapter, you should run the
following command:

ALTER TABLE table_name ADD CONSTRAINT constraint_name DEFAULT 0 <
FOR column_name

Substitute the appropriate table, constraint, and column names in the command.

Likewise, if you want to change the values in the tables created before this option
was made available in the Event Replicator Target Adapter, run the following
command:

UPDATE table_name SET column_name = 0 WHERE column_name IS NULL

Substitute the appropriate table and column names in the command.

Null for Type
Decimal

This option is only useful for Microsoft SQL Server databases. It only becomes
available if the User-Defined Empty Value option is selected (checked).

Select this option (check it) to indicate that zero or null should be used for empty
numeric or integer fields directed to Microsoft SQL Server databases.

The default is to leave this field unselected (unchecked).

This option was introduced in an Event Replicator Target Adapter hot fix, prior to
release 2.6. If you want to set this as the default for tables created before this option
was made available in the Event Replicator Target Adapter, review the instructions
provided in the User-Defined Empty Value field above.
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Field Name

Description

Null for Type
Float

This option is only useful for Microsoft SQL Server databases. It only becomes
available if the User-Defined Empty Value option is selected (checked).

Select this option (check it) to indicate that zero or null should be used for empty
floating point fields directed to Microsoft SQL Server databases.

The default is to leave this field unselected (unchecked).

This option was introduced in an Event Replicator Target Adapter hot fix, prior to
release 2.6. If you want to set this as the default for tables created before this option
was made available in the Event Replicator Target Adapter, review the instructions
provided in the User-Defined Empty Value field above.

Use Loader

Select this option (check it) to indicate that Oracle SQL*Loader, the Teradata
MultiLoad (MLoad) utility, the Microsoft SQL Server bulk copy (bcp) utility, the
DB2 CONNECT IMPORT or the PostgreSQL Loader (psql) utility command should
be used to process and load initial-state data into an Oracle, Teradata, Microsoft
SQL, DB2 or the PostgreSQL database. If you select this option, you should evaluate
the values for the Service, Path, Options, Environment File and Use Stream fields
on this screen, as these fields apply to the use of Oracle SQL*Loader in the Event
Replicator Target Adapter.

The default is to leave this field unselected (unchecked).

For more information on the use of the Oracle SQL*Loader to load initial-state data
in the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide. For more
information on the use of the Teradata MLoad utility to load initial-state data in the
Event Replicator Target Adapter, read Using the Teradata MultiLoad (MLoad) Utility
to Load Initial-State Data, in the Event Replicator Target Adapter User Guide. For more
information on the use of the Microsoft SQL Server bcp utility to load initial-state
data in the Event Replicator Target Adapter, read Using the Microsoft SQL Server
Bulk Copy (bep) Utility to Load Initial-State Data, in the Event Replicator Target Adapter
User Guide. For more information on the use of the DB2 CONNECT IMPORT
command to load initial-state data in the Event Replicator Target Adapter, read
Using the DB2 CONNECT IMPORT Command to Load Initial-State Data, in the Event
Replicator Target Adapter User Guide.

For more information on the use of the PostgreSQL psql command to load initial-state
data in the Event Replicator Target Adapter, read Using the PostgreSQL psql Command
to Load Initial-State Data, in the Event Replicator Target Adapter User Guide.

Oracle Service,
Teradata Tdpip,
Microsoft SQL
Schema Name or
DB2 Alias

If Oracle SQL*Loader will be used to process and load initial-state data into an
Oracle database, optionally specify the Oracle database service name that should
be used with the Oracle SQL*Loader. This is the service name you configured using
the Oracle Net Manager tool. Optionally, if the Oracle EZConnect feature is
supported on this machine, you can specify the machine name, port number, and
database name instead of the service name. If the Oracle database is installed and
running on the same machine as the Event Replicator Target Adapter and only one
Oracle database is installed, this field should be left blank. This is the default. For
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Field Name

Description

more information on the use of the Oracle SQL*Loader to load initial-state data in
the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide.

If the Teradata MLoad utility will be used to process and load initial-state data into
a Teradata database, specify the Teradata Director Program Identifier (TDPID) in
this field. This is usually the first eight characters of the Teradata database name or
the Teradata service name. Teradata database names can be up to 30 characters
long. However, MLoad restrictions for Teradata releases up to Version 12 require
that TDPIDs be eight (8) characters or less. Event Replicator Target Adapter current
logic dynamically determines the TDPID using the first eight characters of the name
specified in this field. If you do not supply a name, the first eight characters of the
Teradata database name is used. Whatever TDPID is used must also be present in
the HOSTS file. Be sure that the specifications in the database option definition and
the specification in the HOSTS file match. For more information on the use of the
Teradata MLoad utility to load initial-state data in the Event Replicator Target
Adapter, read Using the Teradata MultiLoad (MLoad) Utility to Load Initial-State Data,
in the Event Replicator Target Adapter User Guide.

If the Microsoft SQL Server Bulk Copy (bcp) utility will be used to process and load
initial-state data to a Microsoft SQL Server database, optionally specify the MS SQL
Server schema name in this field if the schema name is different from the user login
name. Prior to the release of MS SQL Server 2005, all tables created by MS SQL
Server used the user login name as the default schema name; in MS SQL Server
2005 and later versions, Microsoft suggests that you use "dbo" as the common schema
name (which is different from the user login name). If you have used any MS SQL
Server schema name that is not the same as the user login name, specify your
non-default schema name in the Oracle Service or Teradata Tdpip field. For more
information on the use of the Microsoft SQL Server bcp utility to load initial-state
data in the Event Replicator Target Adapter, read Using the Microsoft SQL Server
Bulk Copy (bep) Utility to Load Initial-State Data, in the Event Replicator Target Adapter
User Guide.

If the DB2 CONNECT IMPORT command will be used to process and load
initial-state data into a DB2 database, specify the alias name of the DB2 database.
For more information on the use of the DB2 CONNECT IMPORT command to load
initial-state data in the Event Replicator Target Adapter, read Using the DB2
CONNECT IMPORT Command to Load Initial-State Data, in the Event Replicator Target
Adapter User Guide.

Path to Loader
Executable

If Oracle SQL*Loader, the Teradata MLoad utility, or the Microsoft SQL Server bulk
copy (bcp) utility will be used to process and load initial-state data into an Oracle,
Teradata, or Microsoft SQL Server database, this field is required.

= For Oracle SQL*Loader support, specify the full path of the Oracle SQL*Loader
executable. You can use the Browse... button to search for the executable on the
machine. For more information on the use of the Oracle SQL*Loader to load
initial-state data in the Event Replicator Target Adapter, read Using the Oracle
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Field Name

Description

SQL*Loader to Load Initial-State Data, in the Event Replicator Target Adapter User
Guide.

® For Teradata MLoad utility support, specify the full path of the Teradata MLoad
utility executable. You can use the Browse... button to search for the executable
on the machine. For more information on the use of the Teradata MLoad utility
to load initial-state data in the Event Replicator Target Adapter, read Using the
Teradata MultiLoad (MLoad) Utility to Load Initial-State Data, in the Event Replicator
Target Adapter User Guide.

= For Microsoft SQL Server bulk copy (bcp) utility support, specify the full path of
the Microsoft SQL Server bep utility executable. You can use the Browse... button
to search for the executable on the machine. For more information on the use of
the Microsoft SQL Server bep utility to load initial-state data in the Event
Replicator Target Adapter, read Using the Microsoft SQL Server Bulk Copy (bcp)
Utility to Load Initial-State Data, in the Event Replicator Target Adapter User Guide.

= For DB2 CONNECT IMPORT command support, specify the full path of the DB2
executable, db2cmd.exe. You can use the Browse... button to search for the
executable on the machine. For more information on the use of the DB2 CONNECT
IMPORT command to load initial-state data in the Event Replicator Target
Adapter, read Using the DB2 CONNECT IMPORT Command to Load Initial-State
Data, in the Event Replicator Target Adapter User Guide.

= For PostgreSQL psql command support, specify the full path of the psql executable
(psql.exe on Windows, psql on Linux). You can use the Browse... button to search
for the executable on the machine. For more information on the use of the
PostgreSQL psql command to load initial-state data in the Event Replicator Target
Adapter, read Using the PostgreSQL psql Utility to Load Initial-State Data, in the
Event Replicator Target Adapter User Guide.

Options
(MSSQL, Oracle
or DB2 only)

If the Microsoft SQL Server Bulk Copy (bcp) utility will be used to process and load
initial-state data into a Microsoft SQL Server database, you can specify the -b (batch
size) option in this field. This option specifies the number of rows per batch of
imported data. Each batch is imported and logged as a separate transaction that
imports the whole batch before being committed. By default, all rows in the data
file are imported as one batch. To distribute the rows among multiple batches, use
the -b option to specify a batch size that is smaller than the number of rows in the
data file. If the transaction for any batch fails, only insertions from the current batch
are rolled back. Batches already imported by committed transaction are unaffected
by a later failure. Do not use this option in conjunction with the -h
("ROWS_PER_BATCH=bb") option. The syntax of the -b option is:
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-b batchsize

If Oracle SQL*Loader will be used to process and load initial-state data into an
Oracle database, the rows option can be specified in this field. The rows option
specifies the number of rows you want to read from the data file before a data save
is performed by the SQL*Loader. The syntax of the rows option is (where nnnnis
the number of rows):

rows=nnnn

Note: Use of the rows option can affect performance if it is set too low. We

recommend using it for testing and debugging purposes only or, if your file is very
large, it can be used to avoid resource restrictions that might arise. For complete
information on the rows option, refer to your Oracle SQL*Loader documentation.

For more information on the use of the Oracle SQL*Loader to load initial-state data
in the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide.

If the DB2 CONNECT IMPORT command will be used to process and load
initial-state data into a DB2 database, there are several options that can be specified
in this field. For a complete description of these options and the use of the DB2
CONNECT IMPORT command to load initial-state data in the Event Replicator
Target Adapter, read Using the DB2 CONNECT IMPORT Command to Load Initial-State
Data, in the Event Replicator Target Adapter User Guide.

Note: This field is not required for Teradata MLoad utility or the PostgreSQL psql
utility support; Any values specified in this field for these targets are ignored.

Environment File

Optionally, specify the file name containing the Oracle environment variables that
should be used with the Oracle SQL*Loader, if the SQL*Loader will be used to
process and load initial-state data into an Oracle database. The Oracle environment
variables are used by UNIX and Linux operating systems. If used, the environment
variable file will contain settings for the PATH, ORACLE_BASE, and
ORACLE_HOME environment variables. You can use the Browse... button to search
for the environment file on the machine.

If the environment variables are defined at the UNIX or Linux system level, this
field should be left blank. This is the default.

For more information on the use of the Oracle SQL*Loader to load initial-state data
in the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide.

Note: This field is not required for Teradata MLoad utility or Microsoft SQL Server

bep utility or the PostgreSQL psql utility support; Any values specified in this field
for these targets are ignored

Use Stream
(Oracle only)

This optional field should only be selected if the Oracle SQL*Loader will be used
to process and load initial-state data into an Oracle database. Select this option
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(check it) to indicate that records should be read in stream mode rather than first
being written to DAT files prior to being loaded into the Oracle database. Stream
mode processing is much faster and greatly reduces the disk space required for this
feature.

The default is to leave this field unselected (unchecked).

For more information on the use of the Oracle SQL*Loader to load initial-state data
in the Event Replicator Target Adapter, read Using the Oracle SQL*Loader to Load
Initial-State Data, in the Event Replicator Target Adapter User Guide.

Note: The use of this field for any target other than Oracle is ignored.

Number of
Parallel Loaders

Specifies the number of parallel loader processes that can run for the given target.
The default is 1.

This avoids a potential error that can occur if a second loader process attempts to
load files into target tables before a previous one is finished. This can occur if, for
example, the user is processing multiple ADARIS loads for the same
source/target/dbid/fnr combination, with the first one larger than the second. The
result will be unusable tables because competing loader processes attempt to load
target tables at the same time.

Setting this to 1 will ensure that only one loader process is allowed to run for that
same table target at a time.

> Once all fields have been specified satisfactorily, click the Save button (L;IIIJ) on the toolbar to
save the target database option definition.
Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.
Specify the name of the new target database option definition on the Save As pop-up window
and then click the OK button.
The definition is saved in the context file.
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Modifying Existing Target Database Option Definitions

~ To modify an existing target database option definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then expand the Target Database Options section.

The target database option definitions are listed.

Locate the definition in the list of option definitions and double-click on the name.

The definition opens on the right side of the Administration tool.

Modify the values of the target database option definition as described in Creating a New
Target Database Option Definition , elsewhere in this section.

Once all fields and options have been specified satisfactorily, click the Save button (L5l on
the toolbar to save the target database option definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Renaming Existing Target Database Option Definitions

~ To rename an existing target database option definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then expand the Target Database Options section.

The target database option definitions are listed.

Locate the definition in the list of option definitions and right-click on the name.

A drop-down menu appears providing you with several options.

Select the Rename option on the drop-down menu.

Event Replicator Target Adapter Administration 97



Using Event Replicator Target Adapter Administration

A Rename dialog for the target database option definition appears.
Supply a new name for the definition in the input field and click OK.

Make sure you have renamed any target definitions that share the same name as the target
database option definition. If you do not do this, the target database option definition will
not get applied to the correct target definition. For more information, read Configuring Target
Definitions for Event Replicator Target Adapter, elsewhere in this guide.

Once all fields have been specified satisfactorily, click the Save button (L5) on the toolbar to
save the target database option definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Deleting Existing Target Database Option Definitions

~ To delete an existing target database option definition:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Target Database Options section.
The target database option definitions are listed.

3 Locate the definition in the list of option definitions and right-click on the name.
A drop-down menu appears providing you with several options.

4  Select the Delete option on the drop-down menu.
A dialog prompting you to verify that you really want to delete the definition appears.

5  Select Yes to delete the definition.
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Specifying Filter Definitions

You can set filter definitions for Event Replicator Target Adapter processing. You do this by creating
and using filter definitions. Transactions that meet the requirements set by filter definitions are not
processed by the Event Replicator Target Adapter (they are filtered out).

= Creating a New Filter Definition
= Filter Definition Processing

= Modifying Filter Definitions

= Renaming Filter Definitions

= Deleting Filter Definitions

| Note: You will need to restart the Event Replicator Target Adapter to fully process any ad-

ditions or changes made to Event Replicator Target Adapter configuration definitions in
the Administration tool. For more information, read Restarting the Event Replicator Target
Adapter, in the Event Replicator Target Adapter User Guide.

Creating a New Filter Definition

> To create a new filter definition:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.
2 On the left side of the Administration tool window, expand the Configuration File section.

3 Right-click on the Filter section and select New from the drop-down menu.
Or:
Select the New command from the File menu and then Filter from the resulting submenu.

An untitled filter definition panel appears on the right side of the Administration tool window,
as shown below:
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Verify and update the values for the filter definition panel, as described in the following table:

Field Name

Description

Description

Optionally, specify a description for the filter definition.

Active

Optionally, select this option (check it) to indicate that this filter definition should
be active. If this option is not selected, this filter definition will not be applied to the
transactions that Event Replicator Target Adapter processes.

The default is to select this option.

Display Message

Optionally, select this option (check it) to indicate that a message should be written
to the log when a transaction is filtered out from Event Replicator Target Adapter
processing because it meets all of the criteria specified by this filter condition.

The default is to unselect this option (uncheck it).

Count

Optionally, specify the number of transactions that can be rejected by this filter
condition if all of the criteria specified by this filter are met. Valid values for this
field are any positive integer or the word "all". For example, if "all" is specified, any
transaction that meets the conditions specified by this filter is rejected. If "6" is
specified, only the first six transactions that meet the conditions specified by this
filter are rejected.

The default is "all".

Database ID

Optionally, specify an Adabas database ID for the filter definition. If a transaction
is processed by the Event Replicator Target Adapter for this database ID, the
transaction is rejected for Event Replicator Target Adapter processing.

File Number

Optionally, specify an Adabas file number for the filter definition. If a transaction
is processed by the Event Replicator Target Adapter for this file number, the
transaction is rejected for Event Replicator Target Adapter processing.
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Field Name Description

Source Optionally, specify the name of an Event Replicator Target Adapter source definition
for the filter definition. If a transaction is processed by the Event Replicator Target
Adapter from this source definition, the transaction is rejected for Event Replicator
Target Adapter processing.

Target Optionally, specify the name of an Event Replicator Target Adapter target definition
for the filter definition. If a transaction is processed by the Event Replicator Target
Adapter for this target database, the transaction is rejected for Event Replicator
Target Adapter processing.

Subscription Optionally, specify the name of an Event Replicator subscription definition for the
filter definition. If a transaction is processed by the Event Replicator Target Adapter
from this subscription, the transaction is rejected for Event Replicator Target Adapter
processing.

Once all fields have been specified satisfactorily, click the Save button (L)) on the toolbar to
save the filter option definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new filter definition on the Save As pop-up window and then click
the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.
Filter Definition Processing

An individual filter definition can specify many conditions (database ID, file number, source,
target, and subscription names). Any transaction that meets all of the conditions in an individual
filter definition is rejected by Event Replicator Target Adapter processing. In other words, the
conditions specified in an individual filter definition are logically ANDed by the Event Replicator
Target Adapter. If a transaction only meets a few of the conditions in an individual filter definition,
it is not rejected for processing.

You can also specify multiple filter definitions for Event Replicator Target Adapter processing. In
this case, if a transaction is rejected by any one of the filter definitions, it is not processed by the
Event Replicator Target Adapter. In other words, the conditions specified by different filter
definitions are logically ORed by the Event Replicator Target Adapter. If a transaction does not
meet all of the filter conditions in any individual filter condition (although it might meet a few
conditions in several different filter conditions) it is still processed by the Event Replicator Target
Adapter.
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Transactions that are filtered out can be identified in the Event Replicator Target Adapter log file,
depending on the setting of the Display Message option in the filter definition.

Modifying Filter Definitions

~ To modify an filter definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then expand the Filter section.

The filter definitions are listed.

Locate the definition in the list of option definitions and double-click on its name.

The definition opens on the right side of the Administration tool.

Modify the values of the filter definition as described in Creating a New Filter Definition ,
elsewhere in this section.

Once all fields and options have been specified satisfactorily, click the Save button (L&) on
the toolbar to save the filter definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Renaming Filter Definitions

~ To rename an existing filter definition:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then expand the Filter section.
The filter definitions are listed.

3 Locate the definition in the list of option definitions and right-click on its name.
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A drop-down menu appears providing you with several options.

Select the Rename option on the drop-down menu.

A Rename dialog for the filter definition appears.
Supply a new name for the definition in the input field and click OK.

Once all fields have been specified satisfactorily, click the Save button (L)) on the toolbar to
save the filter definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Deleting Filter Definitions

~ To delete an existing filter definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then expand the filter section.

The filter definitions are listed.

Locate the definition in the list of option definitions and right-click on its name.

A drop-down menu appears providing you with several options.

Select the Delete option on the drop-down menu.

A dialog prompting you to verify that you really want to delete the definition appears.
Select Yes to delete the definition.
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Configuring Source Definitions for Event Replicator Target Adapter

The Event Replicator Target Adapter supports two types of sources through which replicated data
can be submitted to your RDBMS databases and web services: webMethods EntireX and WebSphere
MQ (MQSeries). Before you can use the Event Replicator Target Adapter, you must set up a source
definition for every unique webMethods EntireX or WebSphere MQ data source you will be using
to retrieve the replicated data for your Event Replicator Target Adapter targets.

= Defining a New webMethods EntireX Source Definition
= Defining a New WebSphere MQ Source Definition

= Specifying Global Source Trace Options

= Modifying Existing Source Definitions

= Renaming Existing Source Definitions

= Deleting Existing Source Definitions

| Note: You will need to restart the Event Replicator Target Adapter to fully process any ad-

ditions or changes made to Event Replicator Target Adapter configuration definitions in
the Administration tool. For more information, read Restarting the Event Replicator Target
Adapter, in the Event Replicator Target Adapter User Guide.

Defining a New webMethods EntireX Source Definition

You must define a webMethods EntireX source definitions for each unique webMethods EntireX
system that the Event Replicator Target Adapter needs to use to access your RDBMS and to com-
municate with Event Replicator for Adabas via webMethods EntireX.

> To define a new webMethods EntireX source definition for Event Replicator Target Adapter:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section.

3  Expand the Sources section.

4  Right-click on the EntireX Communicator section and then select New from the resulting
drop-down menu.

Or:

Select the New command from the File menu and then EntireX Communicator Source from
the resulting submenu.
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A blank webMethods EntireX source definition panel appears on the right side of the Admin-
istration tool window, as shown below:
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5  Specify field values for the webMethods EntireX source definition on the panel. Each field
and option is described in the following table.

Entry Name Description
Description Specify a description for this webMethods EntireX source definition.
Broker ID Specify the location of the webMethods EntireX system that will be sending

replicated data to Event Replicator Target Adapter. The format of this location
must be in the format: hostname: portor tcpip-address:port.

If the host name is the same as the current machine, only the port number need
be specified.
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Entry Name

Description

Service In

Specify the unique name of the webMethods EntireX system that will be receiving
replicated data from the Event Replicator Server. This name should be specified
in the following format and is case-sensitive: Broker class/server/service

Service Out

Specify the unique name of the webMethods EntireX system that will be used to
send initial-state requests from Event Replicator Target Adapter to the Event
Replicator Server. This name should be specified in the following format and is
case-sensitive: Broker class/server/service

Target

Click on the arrow associated with this field and select the target definition to
which replicated data received from this source should be sent.

User ID

Specify the webMethods EntireX user ID required for security purposes. This field
is not optional.

Note: A user ID is required, regardless of whether or not any security is used by
webMethods EntireX.

Token

Specify a unique ID for this source definition. This field is used to uniquely identify
this webMethods EntireX source when multiple sources are used. It is not optional.

A maximum of 32 alphanumeric characters can be specified.

Note: A token is required, regardless of whether or not any security is used by
webMethods EntireX.

Password

Specify the webMethods EntireX password associated with the user ID specified
in the User 1D field.

This option is only required if EntireX is running with security.

Autostart

Select this option (check it) to indicate that this webMethods EntireX source
definition should be automatically started when the Event Replicator Target
Adapter is started.

The default is to leave this option unselected (unchecked).

Security

Select this option (check it) to indicate that system security is activated for this
source.

When you select this option, it indicates that system security is activated; if you
do not select this option, it indicates that system security is not activated.

Display Receives

Select this option (check it) to indicate that messages should be written to the log
files indicating how many bytes were received from this source.

The default is to leave this option unselected (unchecked).

Single
Conversation
Mode

Select this option if your EntireX Broker queues are configured as Destination and
Input queues in the Event Replicator Server and are configured to use Single
Conversation Mode.

The default is to leave this option unselected (unchecked).
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Entry Name

Description

Prefetch Count

Specify the maximum number of records that should be prefetched for this source
before Event Replicator Target Adapter processing occurs for those records.

This field has no effect on queues configured for Single Conversation mode.

Wait Time

Indicate how long this source will wait for a message, in seconds. This is how long
the source will wait to receive a message before it attempts to receive a different
message. For webMethods EntireX sources, the default value is "1s" (one second).

Receive Length

Specify the maximum message size that can be processed by this source. The
default value is 32768 bytes.

Retry Count

Specify the number of times the Event Replicator Target Adapter should attempt
to connect to the source if the connection is unavailable or interrupted. The default
is "0" (zero) times.

Retry Interval

Specify the number of seconds this source should wait between attempts to
reconnect to the source when the connection is down. The default is "10s" seconds.

Compression

Specify the webMethods EntireX data compression level for data coming to the
Event Replicator from this source. Valid compression levels are integers ranging
from "0" (zero, or no compression) to "8" (maximum compression). The default is
HO”‘

Capture Mode

Select this option (check it) to indicate that all incoming Event Replicator messages
should be captured to a sequential file for debugging purposes. This file is stored
with the other log files created for Event Replicator Target Adapter. For more
information, read Managing Event Replicator Target Adapter Log Files and Console
Messages, in the Event Replicator Target Adapter User Guide.

Note:

1. Selecting this option may impact performance.

2. If the Event Replicator Target Adapter is started with capture turned on, any
existing log file is deleted and a new one is created.

Path to File

Specify the fully-qualified name of the capture log file to which Event Replicator
messages will be written if the Capture Mode option is selected. You can click on
the Browse... button associated with this field to select the file.

Once all fields have been specified satisfactorily, click the Save button (L&) on the toolbar to

save the webMethods EntireX source definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.

Specity the name of the new webMethods EntireX source definition on the Save As pop-up
window and then click the OK button.
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The definition is saved in the context file for the Event Replicator Target Adapter.

Defining a New WebSphere MQ Source Definition

You must define an WebSphere MQ source definitions for each unique WebSphere MQ system
that the Event Replicator Target Adapter needs to use to access your RDBMS and to communicate
with Event Replicator for Adabas via WebSphere MQ.

~ To define a new WebSphere MQ source definition for Event Replicator Target Adapter:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.
2 On the left side of the Administration tool window, expand the Configuration File section.
3  Expand the Sources section.
4  Right-click on the WebSphere MQ section and then select New from the resulting drop-down
menu.
Or:
Select the New command from the File menu and then WebSphere MQ Source from the
resulting submenu.
A blank WebSphere MQ source definition panel appears on the right side of the Administration
tool window, as shown below:
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5  Specify field values for the WebSphere MQ source definition on the panel. Each field and
option is described in the following table.

Entry Name Description

Description Specify a description for this WebSphere MQ source definition.
Host Specify the case-sensitive WebSphere MQ host name.

Port Specify the WebSphere MQ port number.

Queue Manager |Specify the case-sensitive WebSphere MQ queue manager name to which you are
trying to connect.

Channel Specify the case-sensitive WebSphere MQ channel name to which you are trying
to connect.
Queue In Specify the case-sensitive WebSphere MQ queue name you want to use to receive

replicated data from the Event Replicator Server.
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Entry Name

Description

Queue Out

Specify the case-sensitive WebSphere MQ queue name you want to use to send
initial-state requests from Event Replicator Target Adapter to the Event Replicator
Server.

Target

Click on the arrow associated with this field and select the target definition to which
replicated data received from this source should be sent.

User ID

Specify the WebSphere MQ user ID required for security purposes.

Password

Specify the WebSphere MQ password associated with the user ID specified in the
User ID field.

Autostart

Select this option (check it) to indicate that this WebSphere MQ source definition
should be automatically started when the Event Replicator Target Adapter is started.

The default is to leave this option unselected (unchecked).

Security

Select this option (check it) to indicate that system security is activated for this
source.

When you select this option, it indicates that system security is activated; if you do
not select this option, it indicates that system security is not activated.

Wait Time

Indicate how long this source will wait for a message, in seconds. This is how long
the source will wait to receive a message before it attempts to receive a different
message. If you are using WebSphere MQ), set the wait time to a value greater than
"0"; its default is "1s" (one second).

Retry Count

Specify the number of times of times the Event Replicator Target Adapter should
attempt to connect to the source if the connection is unavailable or interrupted. The
default is "0" (zero) times.

Retry Interval

Specify the number of seconds this source should wait between attempts to reconnect
to the source when the connection is down. The default is "10s" seconds.

Capture Mode

Select this option (check it) to indicate that all incoming Event Replicator messages
should be captured to a sequential file for debugging purposes. This file is stored
with the other log files created for Event Replicator Target Adapter. For more
information, read Managing Event Replicator Target Adapter Log Files and Console
Messages, in the Event Replicator Target Adapter User Guide.

Note:

1. Selecting this option may impact performance.

2. If the Event Replicator Target Adapter is started with capture turned on, any
existing log file is deleted and a new one is created.

Path to File

Specify the fully-qualified name of the capture log file to which Event Replicator
messages will be written if the Capture Mode option is selected. You can click on
the Browse... button associated with this field to select the file.

Once all fields have been specified satisfactorily, click the Save button (L&) on the toolbar to
save the WebSphere MQ source definition.
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Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new WebSphere MQ source definition on the Save As pop-up window
and then click the OK button.

The definition is saved in the context file for the Event Replicator Target Adapter.

Specifying Global Source Trace Options

You can specify global trace options for your webMethods EntireX and WebSphere MQ sources.

J

Note: You cannot specify global source trace options for a source type that has not been

defined. For example, you cannot specify WebSphere MQ trace options if no WebSphere
MQ sources have been defined.

= Specifying Global webMethods EntireX Trace Options
= Specifying Global WebSphere MQ Trace Options

Specifying Global webMethods EntireX Trace Options

~ To specify global webMethods EntireX trace options:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section.
Expand the Sources section.

Right-click on the EntireX Communicator section and then select Open from the resulting
drop-down menu.

Or:
Double-click on EntireX Communicator.

The Global EntireX Communicator Source panel appears on the right side of the Adminis-
tration tool window, as shown below:
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5  Verify and update the values for the trace option definition panel, as described in the following
table:
Field Name |Description
Description |Specify a description for the trace options.
Trace File |Specify the name of the trace file to be used.
Trace Level |Specify the level of tracing that should be performed.
Valid values range from "0" (no trace) to "5".
If you request that source tracing occur, the trace file is created and is stored with the
other log files created for Event Replicator Target Adapter. For more information, read
Managing Event Replicator Target Adapter Log Files and Console Messages, in the Event
Replicator Target Adapter User Guide.
Note:
1. Turning tracing on (by setting this field to a value greater than 0) may impact
performance.
2. If the Event Replicator Target Adapter is started with trace turned on, any existing
trace file is deleted and a new one is created.
6 . o 1=
Once all fields have been specified satisfactorily, click the Save button (L=) on the toolbar to
save the trace settings.
Or:
Select the Save command on the File menu of the Administration tool.
The trace settings are saved in the context file for the Event Replicator Target Adapter.
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Specifying Global WebSphere MQ Trace Options

~ To specify global WebSphere MQ trace options:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.
2 On the left side of the Administration tool window, expand the Configuration File section.
3  Expand the Sources section.

4  Right-click on the WebSphere MQ section and then select Open from the resulting drop-
down menu.

Or:
Double-click on WebSphere MQ.

The Global WebSphere MQ Source panel appears on the right side of the Administration
tool window, as shown below:
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5  Verify and update the values for the trace option definition panel, as described in the following
table:
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Field Name |Description

Description |Specify a description for the trace options.

Trace File |Specify the name of the trace file to be used.

Trace Level |Specify the level of tracing that should be performed.
Valid values range from "0" (no trace) to "5".

If you request that source tracing occur, the trace file is created and is stored with the
other log files created for Event Replicator Target Adapter. For more information, read
Managing Event Replicator Target Adapter Log Files and Console Messages, in the Event
Replicator Target Adapter User Guide.

Note:

1. Turning tracing on (by setting this field to a value greater than 0) may impact
performance.

2. If the Event Replicator Target Adapter is started with trace turned on, any existing
trace file is deleted and a new one is created.

Once all fields have been specified satisfactorily, click the Save button (L&) on the toolbar to
save the trace settings.

Or:
Select the Save command on the File menu of the Administration tool.

The trace settings are saved in the context file for the Event Replicator Target Adapter.

Modifying Existing Source Definitions

~ To modify an existing source definition:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Configuration File section
and then the Sources section.
The high-level categorizations of the source definitions (EntireX Communicator and Web-
Sphere MQ) appear.

3  Locate the source definition in the EntireX Communicator or WebSphere MQ categorization,
as appropriate and double-click on the name.
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The definition opens on the right side of the Administration tool.

Modify the values of the source definition as described in Defining a New webMethods EntireX
Source Definition and Defining a New WebSphere MQ Source Definition, elsewhere in this
section.

Once all fields have been specified satisfactorily, click the Save button (L5)) on the toolbar to
save the source definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.

Renaming Existing Source Definitions

~ To rename an existing source definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then the Sources section.

The high-level categorizations of the source definitions (EntireX Communicator and Web-
Sphere MQ) appear.

Locate the source definition in the EntireX Communicator or WebSphere MQ categorization
and right-click on the name.

A drop-down menu appears providing you with several options.

Select the Rename option on the drop-down menu.

A Rename dialog for the source definition appears.

Supply a new name for the source definition in the input field and click OK.

Once all fields have been specified satisfactorily, click the Save button (L&) on the toolbar to
save the source definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the context file for the Event Replicator Target Adapter.
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Deleting Existing Source Definitions

~ To delete an existing source definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Configuration File section
and then the Sources section.

The high-level categorizations of the source definitions (EntireX Communicator and Web-
Sphere MQ) appear.

Locate the source definition in the EntireX Communicator or WebSphere MQ categorization
and right-click on the name.

A drop-down menu appears providing you with several options.

Select the Delete option on the drop-down menu.

A dialog prompting you to verify that you really want to delete the source definition appears.

Select Yes to delete the definition.

Configuring Source Definitions for Adabas Analytics Collector MF

The Adabas Analytics Collector MF supports three types of sources through which the analytics
data can be sent to the targets: webMethods EntireX, WebSphere MQ (MQSeries) and Event Rep-
licator Target Adapter. Before you can use the Adabas Analytics Collector MF, you must set up a
source definition for every unique webMethods EntireX, Target Adapter or WebSphere MQ data

source you will be using to send your analytics data for your Adabas Analytics Collector MF targets.

= Defining a New webMethods EntireX Adapter Source Definition

= Defining a New webMethods EntireX Communicator Source Definition
= Defining a New Target Adapter Source Definition

= Setting the Monitor Interval for Target Adapter Sources

= Defining a New WebSphere MQ Source Definition

= Modifying Existing Source Definitions

= Renaming Existing Source Definitions

= Deleting Existing Source Definitions

Note: You will need to restart the Adabas Analytics Collector MF to fully process any addi-

tions or changes made to Adabas Analytics Collector MF configuration definitions in the
Administration tool.
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Defining a New webMethods EntireX Adapter Source Definition

You have to define a webMethods EntireX Adapter source definition for each unique webMethods
EntireX Adapter system that the Adabas Analytics Collector MF needs to use to access your target
and to communicate with Event Replicator for Adabas via webMethods EntireX Adapter.

~ To define a new webMethods EntireX Adapter source definition for Adabas Analytics Collector MF:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MTF section.

Expand the environment section.
Expand the Sources section.

Right-click on the EntireX Adapter section and then select New from the resulting drop-down
menu.

Or:

Select the New command from the File menu and then EntireX Adapter Source from the
resulting submenu.

A blank webMethods EntireX Adapter source definition panel appears on the right side of
the Administration tool window, as shown below:

@ Event Replicator Target Adapter Administration . - 1 = | B |t

File Run Window Help

» @, Target Adapter (@), Untitled 1 [EAP] 22 - B
4 [i& Adabas Analytics Collector MF
a [ EAP Host:  localhost
4 [ Sources Port 4000

. |H EntireX Adapter
5% EntireX Communicator
@, Target Adapter Target: S
Lg WebSphere MQ
s Targets

MName: localhost
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Specity field values for the webMethods EntireX Adapter source definition on the panel. Each
field and option is described in the following table.

Entry Name |Description

Host Specify the host of the webMethods EntireX Adapter system that will be sending analytics
data to Adabas Analytics Collector MF.

Port Specify the port of the webMethods EntireX Adapter system that will be sending analytics
data to Adabas Analytics Collector MF.

Name Specify the name of the webMethods EntireX Adapter system that will be sending analytics
data to Adabas Analytics Collector MF.

Target Click on the arrow associated with this field and select the target definition to which
replicated data received from this source should be sent.

Once all fields have been specified satisfactorily, click the Save button (L&) on the toolbar to
save the webMethods EntireX Adapter source definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specity the name of the new webMethods EntireX Adapter source definition on the Save As
pop-up window and then click the OK button.

The definition is saved in the configuration file for the Adabas Analytics Collector MF.

Defining a New webMethods EntireX Communicator Source Definition

You have to define a webMethods EntireX Communicator source definition for each unique
webMethods EntireX Communicator system that the Adabas Analytics Collector MF needs to use
to access your target and to communicate with Event Replicator for Adabas via webMethods EntireX

Communicator.

~ To define a new webMethods EntireX Communicator source definition for Adabas Analytics Collector MF:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF section.

Expand the environment section.
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4  Expand the Sources section.

5 Right-click on the EntireX Communicator section and then select New from the resulting
drop-down menu.

Or:

Select the New command from the File menu and then EntireX Communicator Source from
the resulting submenu.

A blank webMethods EntireX Communicator source definition panel appears on the right
side of the Administration tool window, as shown below:

g Untitled 1 [LocalEAP] &2 = 8
Host:
Port: 0
Class:
Server:
Service:
Target: -
Parameters
Wait Tirne: 1s

Receive Length: 0
Retry Count: 0
Retry Interval:  10s

Compression: 0

6  Specity field values for the webMethods EntireX Communicator source definition on the
panel. Each field and option is described in the following table.

Entry Name Description

Host Specify the host of the webMethods EntireX Communicator system that will be
sending analytics data to Adabas Analytics Collector MF.

Port Specify the port of the webMethods EntireX Communicator system that will be
sending analytics data to Adabas Analytics Collector MF.

Class Specify the class of the webMethods EntireX Communicator system that will be
sending analytics data to Adabas Analytics Collector MF.

Server Specify the server name of the webMethods EntireX Communicator system that will
be sending analytics data to Adabas Analytics Collector MF.

Service Specify the service of the webMethods EntireX Communicator system that will be
sending analytics data to Adabas Analytics Collector MF.
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Entry Name

Description

Target

Click on the arrow associated with this field and select the target definition to which
replicated data received from this source should be sent.

Wait Time

Indicate how long this source will wait for a message, in seconds. This is how long
the source will wait to receive a message before it attempts to receive a different
message. For webMethods EntireX Communicator sources, the default value is "1s"
(one second).

Receive Length

Specify the maximum message size that can be processed by this source. Entering
as 0 uses the Adabas Analytics Collector MF default value of 32767.

Retry Count

Specify the number of times this source should attempt to connect to the target
RDBMS database or web service if the connection to the connection is down. The
default is "0" (zero) times, meaning connections will not be retried if there is a failed
connect attempt.

Retry Interval

Specify the number of seconds this source should wait between attempts to reconnect
to the target RDBMS database or web service when the connection is down. The
default is "10s" seconds.

Compression

Specify the webMethods EntireX Communicator data compression level for data
coming to the Event Replicator from this source. Valid compression levels are integers
ranging from "0" (zero, or no compression) to "8" (maximum compression). The
default is "0".

Once all fields have been specified satisfactorily, click the Save button (L5) on the toolbar to

save the webMethods EntireX Communicator source definition.

Or:

Select the Save command on the File menu of the Administration tool.

A Save As pop-up window appears.

Specify the name of the new webMethods EntireX Communicator source definition on the
Save As pop-up window and then click the OK button.

The definition is saved in the configuration file for the Adabas Analytics Collector MF.

Defining a New Target Adapter Source Definition

You have to define a Target Adapter source definition for each unique Event Replicator Target
Adapter that the Adabas Analytics Collector MF needs to use to access your target and to commu-
nicate with the Target Adapter.

~ To define a new Target Adapter source definition for Adabas Analytics Collector MF:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere

in this guide.
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6

The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF section.

Expand the environment section.

Expand the Sources section.

Right-click on the Target Adapter section and then select New from the resulting drop-down
menu.

Or:

Select the New command from the File menu and then Target Adapter Source from the res-

ulting submenu.

A blank Target Adapter source definition panel appears on the right side of the Administration
tool window, as shown below:

@ Event Replicator Target Adapter Administration EI@
1 File Run Window Help
- @, Target Adapter @, Untitled 2 [LocalEAP] 22 = 0
a |_Q Adabas Analytics Collector MF
4 [ LocalEap Host: localhost
a [ Sources Port: 4000

. 5 EntireX Communicator
» | @ Target Adapter
Eg WebSphere MQ Target Adapter Version: |33 =

. @ Targets
Target: -

Target Adapter Name:  lecalhost

Specify field values for the Target Adapter source definition on the panel. Each field and option
is described in the following table.

Event Replicator Target Adapter Administration 121



Using Event Replicator Target Adapter Administration

Entry Name Description
Host Specify the case-sensitive Target Adapter host name.
Port Specify the Target Adapter JMX port number. The default of 4000 is given.

Target Adapter Name |Specify the name for the Target Adapter to distinguish in on the target.

Target Adapter Version |Specify the version of the Target Adapter.

Target Click on the arrow associated with this field and select the target definition
to which replicated data received from this source should be sent.

Once all fields have been specified satisfactorily, click the Save button (EL_-'H) on the toolbar to
save the Target Adapter source definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new Target Adapter source definition on the Save As pop-up window
and then click the OK button.

The definition is saved in the configuration file for the Adabas Analytics Collector MF
Setting the Monitor Interval for Target Adapter Sources

The default monitoring interval for the collection of metrics from Target Adapter sources is 5
seconds. This can be overridden by right-clicking the Adabas Analytics Collector MF > ColTect-
orName > Sources > Target Adapter node in the display and selecting Parameter:

r —
@ Event Replicator Target Adag-ter Administration :

File Run Window Help

| B E e
- @ Target Adapter
4 |_Q Adabas Analytics Collector MF

4 [y EAP

4 E Sources

y Ea EntireX Communicator

» | @, Target Aclantar
[ WebSphe Mew

; Targets ‘

Parameter

Then setting the interval as follows:
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"

@, Modify Target Adapter P... (ERES)

Monitor Interval: | 50s

0K Cancel

s

n_n

The interval should be specified as a number followed by "s", indicating the number of seconds
elapsed between each collection of metrics from the Target Adapter.

| Note: This parameter setting is global for all Target Adapter sources.

Defining a New WebSphere MQ Source Definition

You have to define a WebSphere MQ source definition for each unique WebSphere MQ system
that the Adabas Analytics Collector MF needs to use to access your target and to communicate
with Event Replicator for Adabas via WebSphere MQ.

~ To define a new WebSphere MQ source definition for Adabas Analytics Collector MF:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF section.

3 Expand the environment section.

4  Expand the Sources section.

5  Right-click on the WebSphere MQ section and then select New from the resulting drop-down
menu.

Or:

Select the New command from the File menu and then WebSphere MQ Source from the
resulting submenu.

A blank WebSphere MQ source definition panel appears on the right side of the Administration
tool window, as shown below:
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4 I_Q Adabas Analytics Collector MF
a [y EAP
4 [ Sources
. & EntireX Communicator
> @ Target Adapter
- |5 WebSphere MQ

[ @ Event Replicator Target Adapter Administration = | B |t
File Run Window Help
| g v § -ito
. @ Target Adapter 24 Untitled 1 [EAP] 52 - 0

Host:
Port: a
Queue Manager:

Channel:

3 Targets

Queue Mame:

Parameters
Retry Count: 0

Retry Interval:  10s

6  Specify field values for the WebSphere MQ source definition on the panel. Each field and
option is described in the following table.

Entry Name Description
Host Specify the case-sensitive WebSphere MQ host name.
Port Specify the WebSphere MQ port number.

Queue Manager

Specify the case-sensitive WebSphere MQ queue manager name to which you are
trying to connect.

Channel

Specify the case-sensitive WebSphere MQ channel name to which you are trying
to connect.

Queue Name

Specify the case-sensitive WebSphere MQ queue name you want to use to receive
replicated data from the Event Replicator Server.

Target Click on the arrow associated with this field and select the target definition to which
replicated data received from this source should be sent.

Retry Count Specify the number of times this source should attempt to connect to the target if
the connection to the connection is down. The default is "0" (zero) times.

Retry Interval  |Specify the number of seconds this source should wait between attempts to reconnect

to the target when the connection is down. The default is "10s" seconds.
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Once all fields have been specified satisfactorily, click the Save button (L)) on the toolbar to
save the WebSphere MQ source definition.

Or:
Select the Save command on the File menu of the Administration tool.
A Save As pop-up window appears.

Specify the name of the new WebSphere MQ source definition on the Save As pop-up window
and then click the OK button.

The definition is saved in the configuration file for the Adabas Analytics Collector MF.

Modifying Existing Source Definitions

~ To modify an existing source definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF node, environment node and then the Sources section.

The high-level categorizations of the source definitions (EntireX Communicator, Target Ad-
apter and WebSphere MQ) appear.

Locate the source definition in the EntireX Communicator, Target Adapter or WebSphere
MQ categorization, as appropriate and double-click on the name.

The definition opens on the right side of the Administration tool.

Modify the values of the source definition as described in Defining a New webMethods EntireX
Source Definition, Defining a New Target Adapter Source Definition and Defining a New
WebSphere MQ Source Definition, elsewhere in this section.

Once all fields have been specified satisfactorily, click the Save button (L) on the toolbar to
save the source definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the configuration file for the Adabas Analytics Collector MF.
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Renaming Existing Source Definitions

~ To rename an existing source definition:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.

The Administration tool window appears.

On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF node, environment node and then the Sources section.

The high-level categorizations of the source definitions (EntireX Communicator, Target Ad-
apter and WebSphere MQ) appear.

Locate the source definition in the EntireX Communicator, Target Adapter or WebSphere
MQ categorization and right-click on the name.

A drop-down menu appears providing you with several options.

Select the Rename option on the drop-down menu.

A Rename dialog for the source definition appears. Here is sample dialog for renaming a
webMethods EntireX source definition:

[ |
@ Rename &J

Please enter a new name for EntireX Communicater Source:

BKR1|

| ok || Cancel |

Supply a new name for the source definition in the space provided and click OK.

Once all fields have been specified satisfactorily, click the Save button (4= on the toolbar to
save the source definition.

Or:
Select the Save command on the File menu of the Administration tool.

The definition is saved in the configuration file for the Adabas Analytics Collector MF.
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Deleting Existing Source Definitions

~ To delete an existing source definition:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 On the left side of the Administration tool window, expand the Adabas Analytics Collector
MF node, environment node and then the Sources section.
The high-level categorizations of the source definitions (EntireX Communicator, Target Ad-
apter and WebSphere MQ) appear.

3  Locate the source definition in the EntireX Communicator, Target Adapter or WebSphere
MQ categorization and right-click on the name.
A drop-down menu appears providing you with several options.

4  Select the Delete option on the drop-down menu.

A dialog prompting you to verify that you really want to delete the source definition appears.

5  Select Yes to delete the definition.

Verifying Your Source Definition Connections

Event Replicator Target Adapter provides two commands (batch utilities) you can use to verify
the connection between your environment and the source definition.

@ Caution: Do not run these commands if Event Replicator Target Adapter is already started.

If it is started, stop it before running these commands. In addition, both of these commands
will drain the input queue if anything is in it.

These commands are located in the bin directory, wherever the Event Replicator Target Adapter
source code and program files are installed.

" Usetheetbivp command to verify the connection between your environment and webMethods
EntireX.

" Use the mgsivp command to verify the connection between your environment and WebSphere

MQ.

At a command prompt, navigate to the bin directory and enter the appropriate command, using
one of the following syntaxes:

etbivp brokerID class/server/service tracelevel (scm userid token password)
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or
mqgsivp queuemgr host port channel queue tracelevel

where:

® brokerIDis the URL (host:port) of the webMethods EntireX Broker system to which you are

trying to connect.

B class/server/serviceis the case-sensitive class, server, and service name of the webMethods
EntireX Broker to which you are trying to connect.

" queuemgr is the case-sensitive WebSphere MQ queue manager name to which you are trying to
connect.

" host is the WebSphere MQ host name.

" port is the WebSphere MQ port number.

® channel is the case-sensitive WebSphere MQ channel to which you are trying to connect.

" queue is the case-sensitive WebSphere MQ queue name to which you are trying to connect.

" tracelevel is the trace level that should be used for the connection attempt. Valid values range
from "0" (no trace) through "5". The default is "0".

Optional for etbivp if the EntireX Broker queue is configured for Single Conversation Mode:

" scmindicates you are connecting to an input queue configured for Single Conversation Mode.
" useridis the Broker userid.

" tokenis the user token (Single Conversation Mode).

" passwordis an optional password if the EntireX Broker is running in secured mode.

If errors occur when you run etbivp or mgsivp, rerun them using a trace level setting of "3". Then
submit the trace log to your webMethods EntireX or WebSphere MQ administrators to identify
the problem. For more information about Event Replicator Target Adapter log files, read Managing

Event Replicator Target Adapter Log Files and Console Messages, in the Event Replicator Target Adapter
User Guide.

Reviewing and Dynamically Altering Definitions

You can review all of the configuration definitions you have specified in the Administration tool.
In addition, you can dynamically alter some of them while the Event Replicator Target Adapter
is running; there is no need to restart the Event Replicator Target Adapter to pick up these changes.

| Note: Some configuration definitions can only be altered in the configuration area of the

Administration tool. Changes to these settings require that you restart the Event Replicator
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Target Adapter to fully process the changes. For more information, read Restarting the Event
Replicator Target Adapter, in the Event Replicator Target Adapter User Guide.

~ To review configuration definitions in the Administration tool and optionally modify the editable fields:

1

Start up the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

Verify that the Event Replicator Target Adapter is started. If is not, start it now. For more in-
formation, read Starting the Event Replicator Target Adapter, in the Event Replicator Target Adapter
User Guide

On the left side of the Administration tool window, expand the Target Adapter section and
then expand the Configurations section.

The configuration definitions are listed under Configurations.

Click on any definition under Configurations

The specifications for configuration definition you selected appear on the right side of the
window, where you can review them.

Any fields on the right side of the window that appear in bright blue can be dynamically
altered. For example, in the following window the DbErrorContinue and
DbDeleteBeforelnsert properties can be dynamically altered.
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DbTvpe auta
DbBatchCount a
DbHyphenConvert

DblowerCase false
DbMUOcurrence false
DblseCuote false
DbErrorContinue false
DbDeleteBeforelnsert false
DbCompatiblez3 false
DblUpdateTolnsert false
DbkeepEmptytalue false
DbConnectionf.euse false
Dbloader false
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DbloaderUsestream false
DblLoaderPath

DblLoaderOptions
DblLoaderEnvironmentFile
DbUserDefineEmplyvalue false
DbrullForTypeDecimal false
DbMullForTypeFloat false
DbSyneDDL ignore

Refresh |

5  Optionally, modify any fields you want that appear in bright blue on the right side of the

window. When all your updates are made, click the Save button (I-Ill) on the toolbar to save

the configuration definition.

Or:

Select the Save command on the File menu of the Administration tool.

The configuration definition is saved in the context file for the Event Replicator Target Adapter.

Reviewing Log Files

You can review all of the Event Replicator Target Adapter log files located in the \logs subdirectory

wherever your Event Replicator Target Adapter program data files are installed.

~ To review log files in the Administration tool:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere

in this guide.

The Administration tool window appears.
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Verify that the Event Replicator Target Adapter is started. If is not, start it now. For more in-
formation, read Starting the Event Replicator Target Adapter, in the Event Replicator Target Adapter
User Guide.

On the left side of the Administration tool window, expand the Target Adapter section and
then expand the Logs section.

The log files are listed under Logs.

Click on any log file under Logs

The contents of the log file appear on the right side of the screen. The following example

shows one selected log file's contents on the right side of the screen:

Note: You can use the Refresh button to refresh the display.

Q Event Replicator Target Adapter Administration

File Wiew Run ‘Window Help

|

e

[ @

iy

|

L& Configuration File
=1-#4 Configurations

E]---E Sources

[]---ﬂg Target Database Options
=-@ Targets

@; Target Adapker

-l . Configurations

akalin: g
hast-manager. 2013-05-06.lag
localhost_access_log, 2013-05-06.k»
localhost, 2013-05-06.log
manager.2013-05-06.lag
i sglrep.log
I:I--‘é'; Stakus

i1 rataling,2013-05-06.log &3

May 06, 2013 12:58:55 AM org,apache.catalina. core, AprLifecyclelistener inik

INFO: The APR based Apache Tomcat Mative library which allows optimal performance in production environmenks was
May 06, 2013 12:58:56 AM org.apache.coyote. AbstractProtocol init

IMNFO: Initializing ProtocolHandler [*http-bio-4005"]

May 06, 2013 12:58:56 AM org.apache.catalina. skartup. Catalina load

IMFO: Initialization processed in 1465 ms

May 06, 2013 12:58:56 AM org.apache.catalina. core. StandardService skartInternal

INFO: Starting service Catalina

May 06, 2013 12:58:56 AM org,apache catalina.core, StandardEngine starkInternal

IMFO: Starting Servlet Engine: Apache Tomcat)7.0.29

May 06, 2013 12:58:56 AM org.apache.catalina. startup. HostCanfig deplovDirectary

INFO: Deploving web application directory C:\ProgramDatalSoftware AG\Event Replicator Targek Adapkeriwz. 8. 0\web
May 06, 2013 12:58:57 AM org.apache . catalina. skartup, HostConfig deployDirectory

INFO: Deploving web application directory C:\ProgramData’Software AGIEvent Replicator Targek Adapkeriwz. 8. 0iweb
May 06, 2013 12:58:57 AM org.apache.catalina. startup. HostConfig deplovDirectory

INFO: Deploving web application directory C:\ProgramDatalSoftware AG\Event Replicator Targek Adapkeriwz. 8. 0\web
May 06, 2013 12:58:57 AM org.apache . catalina. skartup, HostConfig deployDirectory

INFO: Deploying web application directory CiiProgramData’Software AGIEvent Replicator Targek Adapkeriwz, 8, 0iweb
May 06, 2013 12:58:57 AM org.apache.catalina. startup, SetContextPropertiesRule begin

WARNING: [SetContextPropertiesRule]{Context} Setting property 'antifesourcesLocking' ta 'true’ did not find a match
May 06, 2013 12:59:03 AM org.apache . catalina. skartup, HostConfig deployDirectory

INFO: Deploying web application directory CiiProgramData’Software AGIEvent Replicator Targek Adapkeriwz, 8, 0iweb
May 06, 2013 12:59:03 AM org.apache.coyote, AbstractProtocol start

IMFO: Starting ProtocolHandler [“http-bio-4005"]

May 08, 2013 12:59:03 AM org.apache.catalina.startup.Catalina start

INFO: Server starkup in 6943 ms

KN —
Refresh |

o

-
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Reviewing Event Replicator Target Adapter Statistics

As records are received and processed by the Event Replicator Target Adapter, statistics are
passively updated. When the Event Replicator Target Adapter shuts down, the final statistics for
the session are written to a log file with a name in the format ArtMetrics_yyyymmdd_hhmmss.1og,
where yyyymmdd_hhmmss is the date and time that the log file is written. You can review all of the
Event Replicator Target Adapter log files located in the \logs subdirectory wherever your Event
Replicator Target Adapter program data files are installed.

You can also review the ongoing Event Replicator Target Adapter processing statistics from the
Administration tool.

~ To review the ongoing Event Replicator Target Adapter processing statistics in the Administration tool:

1  Startup the Administration tool, as described in Starting the Administration Tool, elsewhere
in this guide.
The Administration tool window appears.

2 Verify that the Event Replicator Target Adapter is started. If is not, start it now. For more in-
formation, read Starting the Event Replicator Target Adapter, in the Event Replicator Target Adapter
User Guide.

3 On the left side of the Administration tool window, expand the Target Adapter section and
then expand the Status section.

The statistics areas are listed under Status.

4  Click on any statistic area under Status

The processing statistics for that area appear on the right side of the screen. The following
example shows the status of the configuration engine on the right side of the screen:

| Note: You can use the Refresh button to refresh the display.
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(&) Event Replicator Target Adapter Administration
Fle Run Window Help
> &
= L Configuration File ';" Jengine [Engine-0 53 = g
B w ) Configurations
{5l Engine Name [ value I
{1 Repository SrcRleceiveCount 1
@5 Filter XmiCaptureFies 0
- Sources ProcessRequestCals 0
03 Target Database Options ProcessRequestTrans 0
#-@ Targets Splitter Calltequest 0
=@, Target Adapter Sphitter\aits 0
| =l Configurations SplitterhNoWaits 0
I Hal Logs DbRetries (]
| E-al Status EnghiumMsgsl t10Ms 0
| W =noine Erngne-0 EnghiumMsgsLt50Ms ]
&, [idbc/OB2(Windons) EnghumMsgsLt100Ms 0
| & fsource/ART1 EnghumiMsgsL t995Ms 0
&, fsource FleSource EnghumiMsgsMtDd 15ee 0
&, fsourceMQOUTL Enghimivisgs 0
R, ftargetiMyIMS artLasthverage 0
%. ftargetiterracota SPrintArtTime False
State Running
Refresh
|
I
|
I
| Target Adapter is active. H

The following table provides lists each of the statistics collected, with a brief explanation of each.

] Note: This list may not be complete or comprehensive. Changes to the statistics collected

may change at any time.

Category Type Statistic Description
Engine artLastAverage Event Replicator Target Adapter average
(/fengine/...) processing time.

This value is the average of the backend
Event Replicator Target Adapter internal
processing time. It is expressed in
milliseconds. There are two parts of such
backend processing time:

® The first part is RDBMS-related elapsed
time, including JDBC SQL statement
execution time and database metadata
retrieval time.

® The second part is the Event Replicator
Target Adapter internal processing time.

Event Replicator Target Adapter Administration 133



Using Event Replicator Target Adapter Administration

Category Type Statistic Description

The value of artLastAverage is calculated as
the total time spent in backend Event
Replicator Target Adapter internal
processing during the last minute divided
by the number of backend calls occurring in
that minute.

DbRetries The number of database retry attempts.

EngNumMsgs Total number of messages processed.

EngNumMsgsLt100Ms |The number of messages processed in under
100 milliseconds

EngNumMsgsL.t10Ms The number of messages processed in under
10 milliseconds.

EngNumMsgsLt50Ms The number of messages processed in under
50 milliseconds.

EngNumMsgsL.t999Ms | The number of messages processed in under
999 milliseconds.

EngNumMsgsMt001Sec |The number of messages processed in over
001 second.

ProcessRequestCalls The number of call requests processed.

ProcessRequestTrans The number of transaction requests
processed.

SplitterCallRequest The number of asynchronous process calls
split.

SplitterNoWaits The number of splitter calls completed with
no waits.

SplitterWaits The number of splitter calls that waited for
a resource.

sPrintArtTime Event Replicator Target Adapter display
statistics time.

SrcReceiveCount The number of receives issued.

State The engine state.

XmlCaptureFiles The number of capture files written.

File Source Fileld The file ID.

(/source/sourcenarme) FileLastException The last exception time.
FileNumBytesReceived |The number of bytes received.
FileNumCommits The number of commits.
FileNumExceptions The number of exceptions.

FileNumMsgs The number of messages.
FileNumRollbacks The number of rollbacks.
FileProcessingTime The processing time.
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Category Type Statistic Description
FileTimeException The last exception time.
FileTimeShutdown The shutdown time.
FileTimeStart The start time.
State The current state.
TransactionInfo Last transaction information.
Heartbeat artTime Time when message arrives at ART.
(/heartbeat/destinationname) artTimeMilli artTime in milliseconds.
creationTime Time the URBS was created.
ctimeMilli creationTime in milliseconds.
destination Destination Name.
destinationType Destination Type.
eventld Event Identification.
hbtmMilli InfoTime in milliseconds.
hbtnMilli newestltem time in milliseconds.
hbtoMilli oldestItem time in milliseconds.
hsdrMilli readFromSlog time in milliseconds .
hsdwMiilli readFromSlog time in milliseconds.
infoTime Timestamp when Unit-of-Work status
obtained from Entire Broker.
latency Heartbeat Latency - time span between
creationTime and artTime.
maxBytes Max. value of bytes in one UOW- determined
at infoTime *).
maxMessages Max. value of messages in one UOW -
determined at infoTime *) .
newestltem Timestamp when newest item was stored in
message queue - determined at infoTime ¥).
nucleusld Nucleus ID.
numberBytes Current number of bytes on queue -
determined at infoTime *).
numberHeartbeats Total Number of Heartsbeats.
numberMessages Current number of messages on queue -
determined at infoTime ¥).
numberUows Current number of UOWs on queue -
determined at infoTime *).
oldestltem Timestamp when oldest item was stored in

message queue - determined at infoTime *).
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Category Type Statistic Description
processingTime Heartbeat processing time - time span
between creationTime and infoTime or zero
if not a Broker destination.
readFromSlog Timestamp when heartbeat was read from
SLOG **).
replicatorld Replicator ID.
slogTime Time on SLOG *¥).
writtenToSlog Timestamp when heartbeat was written to
SLOG *¥)
Latency source Source Name
(/latency/source.target.subscription) target Target Name
subscription Subscription Name
messageSize Total Size of all Messages
numberMessages Total Number of Messages
latencyReplicator Total Latency of the Replicator
latencyMiddleware Total Latency of the Middleware
latencyTargetAdapter Total Latency of the Target Adapter
RDBMS Target artExecLt10Ms Event Replicator Target Adapter processes
(/jdbc/targetname) executed in under 10 milliseconds.
artExecLt50Ms Event Replicator Target Adapter processes
executed in under 50 milliseconds.
artExecLt100Ms Event Replicator Target Adapter processes
executed in under 100 milliseconds.
artExecL.t999Ms Event Replicator Target Adapter processes
executed in under 999 milliseconds.
artExecMt001Sec Event Replicator Target Adapter processes
executed in over 1 second.
artLastAverage Event Replicator Target Adapter average
processing time.
This value is the average of the backend
Event Replicator Target Adapter internal
processing time. It is expressed in
milliseconds. There are two parts of such
backend processing time:
® The first part is RDBMS-related elapsed
time, including JDBC SQL statement
execution time and database metadata
retrieval time.
® The second part is the Event Replicator
Target Adapter internal processing time.
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Category Type Statistic Description

The value of artLastAverage is calculated as
the total time spent in backend Event
Replicator Target Adapter internal
processing during the last minute divided
by the number of backend calls occurring in
that minute.

DbName The database name.

DbVersion The database version.

DbUrl The database URL.

DbDriverClass The database driver class.

DbDriverName The database driver name.

DbDriverVersion The database driver version.

dbExecLt10Ms JDBC processes executed in under 10
milliseconds.

dbExecLt50Ms JDBC processes executed in under 50
milliseconds.

dbExecLt100Ms JDBC processes executed in under 100
milliseconds.

dbExecLt999Ms JDBC processes executed in under 999
milliseconds.

dbExecMt001Sec JDBC processes executed in over 1 second.

DbUserName The database user name.

Commits The number of commits to this database.

Connections The number of connections to this database.

ConnectionsReused The number of connections reused.

lastAverage JDBC average processing time.

Event Replicator Target Adapter records the
time it takes to execute SQL statements via
JDBC. It then calculates the JDBC average
processing time by dividing the total JDBC
elapsed time (in milliseconds) for all requests
during the last minute by the total number
of JDBC requests in milliseconds in the last
minute.

This value is only updated when there are
JDBC function calls. It is usually zero unless
SQL statements are being heavily processsed.

Note: A single JDBC function call may

contain more than one SQL statement.
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Category Type Statistic Description

sFakelUD The number of fake DB insert/update/delete
attempts.
sPrintArtTime Event Replicator Target Adapter display
backend statistics time.

Statements The number of statements for this database.
TimeLastConnection The time of last connection.
TransactionTime Total RDBMS time.

Subscription ProcessRequestCalls The number of transaction requests.
TransactionInfo Last transaction information.

Table Table Table Name

(/table/tablename) Target Target Name
Inserts Table Inserts
Updates Table Updates
Deletes Table Deletes
Total Commands Table Total Commands
dblnsertExecLt10Ms JDBC Insert Execution Time <10Ms
dblInsertExecl.t50Ms JDBC Insert Execution Time <50Ms
dbInsertExecLt100Ms JDBC Insert Execution Time <100Ms
dblInsertExec.t999Ms JDBC Insert Execution Time <999Ms
dblInsertExecl.t060Sec JDBC Insert Execution Time < 60s
dbInsertExecMt001Min |JDBC Insert Execution Time >1 Min
dbUpdateExecLtl0Ms  |JDBC Update Execution Time <10Ms
dbUpdateExecLt50Ms  |JDBC Update Execution Time <50Ms
dbUpdateExecLt100Ms |JDBC Update Execution Time <100Ms
dbUpdateExecLt999Ms |JDBC Update Execution Time <999Ms
dbUpdateExecLt060Sec |JDBC Update Execution Time < 60s
dbUpdateExecMt001Min |JDBC Update Execution Time >1 Min
dbDeleteExecL.t10Ms JDBC Delete Execution Time <10Ms
dbDeleteExecL.t50Ms JDBC Delete Execution Time <50Ms
dbDeleteExecl.t100Ms JDBC Delete Execution Time <100Ms
dbDeleteExecl.t999Ms JDBC Delete Execution Time <999Ms
dbDeleteExecL.t060Sec JDBC Delete Execution Time < 60s
dbDeleteExecMt001Min |JDBC Delete Execution Time >1 Min

webMethods EntireX Source BrkExceptionNum The number of exceptions.

(/source/sourcename) BrkExceptionTime The last exception time.
BrkExceptionType The last exception type.
Brkld The webMethods EntireX Broker ID.
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Category Type Statistic Description
BrkInfo webMethods EntireX Broker information.
BrkNumBytesReceived |The number of bytes received.
BrkNumBytesSent The number of bytes sent.
BrkNumCommits The number of commits performed.
BrkNumMsgs The number of messages processed.
BrkNumMsgsLt100Ms  |The number of messages received in under
100 milliseconds.
BrkNumMsgsLt10Ms The number of messages received in under
10 milliseconds.
BrkNumMsgsLt50Ms The number of messages received in under
50 milliseconds.
BrkNumMsgsLt999Ms  |The number of messages received in under
999 milliseconds.
BrkNumMsgsMt001Sec |The number of messages received in over
001 second.
BrkNumPrefetchMax The maximum number of prefetched
messages.
BrkNumRcvs The number of messages received.
BrkNumRollbacks The number of rollbacks.
BrkNumSends The number of sends.
BrkNumUows The number of UOWs.
BrkTimeCommit The last commit time.
BrkTimeReceive The last receive time.
BrkTimeRollback The last rollback time.
BrkTimeSend The last send time.
BrkTimeShutdown The shutdown time.
BrkTimeStart The start time.
State The current state.
Transactionlnfo Last transaction information.
WebSphere MQ Source MgqsCfgHost The WebSphere MQ host machine.
(/source/sourcenarne) MgqsCfgPort The WebSphere MQ port number.
MgsLastException The last exception.
MgsNumBytesReceived |The number of bytes received.
MgsNumBytesSent The number of bytes sent.
MgsNumCommits The number of commits.
MgsNumExceptions The number of exceptions.
MgsNumMsgs The number of messages.
MgsNumRcvs The number of receives.
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Category Type Statistic Description
MgsNumRollbacks The number of rollbacks.
MgsNumSends The number of sends.
MgsTimeCommit The last commit time.
MgqsTimeException The last exception time.
MgsTimeReceive The last receive time.
MgsTimeRollback The last rollback time.
MgqsTimeSend The last send time.
MgsTimeShutdown The shutdown time.
MgsTimeStart The start time.
State The current state.
TransactionInfo Last transaction information.
JMS Target JMSProvider The URL of the JMS provider.
(/source//<targetname>) JMSFactory The JMS factory class in use.
JMSConnection The configured connection factory.
JMSDestination The destination topic.
JMSNumCreates The number of create statements processed.
JMSNumlInserts The number of insert statements processed.
JMSNumUpdates The number of update statements processed.
JMSNumDeletes The number of delete statements processed
JMSNumDrops The number of drop statements processed.
Terracotta Target Parameter The location of the ehcache.xml file.
(/target/<targetname>) GenericNumCreates The number of create statements processed.
GenericNumlInserts The number of insert statements processed.
GenericNumUpdates The number of update statements processed.
GenericNumDeletes The number of delete statements processed.
GenericNumDrops The number of drop statements processed.
GenericNumPopulates  |The number of populate statements

processed.

*) value might be zero if no messages are stored in the message queue at infoTime.

**) value might be zero if heartbeat was not written to SLOG.
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6 Supported Relational Databases *

The following relational databases (RDBMS) are supported by Event Replicator Target Adapter

Administration:
RDBMS Support Required JDBC Driver
DB2 9.1 for open systems, or later db2jcc4.jar

DB2 Universal Database (UDB) version 9 for z/OS,
or later

db2jcc4.jar
db2jcc_license_cisuz.jar

Microsoft SQL Server 2005 and later

sqljdbc4.jar

MySQL 5.0.17, or later

mysql-connector-java-v.v.s-bin.jar , where v.r.s
represents the MySQL release number.

Oracle 10g or later

0jdbc7.jar

PostgreSQL 9.2 or later

postgresql-v.r-1002.jdbc4.jar, where v and r represent the
first two parts of the PostgreSQL version number.v. r. s

Teradata Version 2 Release 1.2 for open systems,
or later

tdgssconfig.jar
terajdbc4.jar

" The versions represented here are the minimum required target RDBMS and driver versions
tested with Event Replicator Target Adapter. In general, when a vendor drops support for a par-
ticular product or version, Software AG support will also be dropped. You should use the latest
appropriate driver from your vendor for the target you are replicating to.
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target database processing options
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modifying, 97
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configuring, 54, 80
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Microsoft SQL Server databases, 55
modifying, 78
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